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General Information

Overview 
KVM2132P / KVM2116P / KVM1116P KVM Switches

Note: Save these instructions. Read and adhere to all the instructions. All servicing must be 
performed by authorized personnel only.

The KVM switch allows local and remote users to monitor and access multiple servers from a single 
console. The switch models differ by number of buses and KVM ports.  

•  Each bus permits a separate user session so that up to three (KVM2132P or KVM2116P) 
concurrent independent connections to the attached servers can take place.

•  The switches use TCP/IP communications protocol. They can be accessed by their IP addresses 
from anywhere on the LAN, WAN, or Internet. The location of the connecting computer is 
irrelevent. 

•  Remote users log in using a browser or stand-alone Windows or Java GUI applications. Java 
allows the switches to work with JRE (Java Runtime Environment) enabled operating systems, 
ensuring multi-platform operability. 

•  The client software allows operators to exchange keyboard, video and mouse signals with the 
servers attached to the switches just as if they were working on the equipment directly. 

•  Up to 32 (KVM2132P) users can share the switch's buses. A Message Board feature allows them 
to communicate with each other to facilitate port sharing. 

•  Administrators can perform maintenance tasks from installing and running GUI applications, to 
BIOS level troubleshooting, routine monitoring, concurrent maintenance, and system 
administration.

•  Local console operation is accomplished by entering hotkey combinations from the keyboard with 
a full screen GUI display. 

•  The Auto Scan feature permits automatic switching from port to port at user-specified intervals, 
while the Panel Array Mode can display the video output of up to 42 servers at the same time. 

•  CAT 5e cable links the switch to the servers. A 16 or 32 port switch can be installed in a 1U rack, 
and use the internal network wiring in most modern commercial buildings. 

•  The switch receives keyboard input directly. There is no software installation. 
•  Download firmware updates from www.apc.com. 
•  Adapter ID function stores port information like the adapter ID, OS, keyboard language, adapter 

name, operation modes and more. When a KVM Adapter Cable is moved from one port to 
another, the switch recognizes the adapter cable at the new location. 

•  Upgrade the entire installation from a single remote console located anywhere in the world.
•  Virtual Media support.

SKU Bus Support KVM Ports
KVM2132P 1 Local, 2 Remote 32
KVM2116P 1 Local, 2 Remote 16
KVM1116P 1 Local shared with 1Remote 16
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KVM2132P / KVM2116P KVM Switches only

•  Dual power is available on KVM2132P and KVM2116P. Power cords plugged into separate 
power sources ensure power to the switch if one power sources fails.

•  Variable fan speed: changes according to the switches temperature.
•  PDU connection port allows administrators to boot or reboot servers.
•  Two 10/100/1000 Mbps NICs for redundant LAN or two IP operations.

Safety
Read all of these instructions. Save them for future reference. Follow all warnings and instructions 
marked on the device.

DANGER
HAZARD OF ELECTRIC SHOCK

•  Do not use the device near water, Never spill liquid of any kind on the device. 
•  Unplug the device from the wall outlet before cleaning. Do not use liquid or aerosol 

cleaners. Use a damp cloth for cleaning.
•  The device should be operated from the type of power source indicated on the 

marking label. If you are not sure of the type of power available, consult your 
dealer or local power company. 

•  To prevent damage to your installation it is important that all devices are properly 
grounded. The device is equipped with a 3-wire grounding type plug. This is a 
safety feature. If you are unable to insert the plug into the outlet, contact your 
electrician to replace the outlet. Do not attempt to defeat the purpose of the 
grounding-type plug. Always follow local/national wiring codes. 

•  If an extension cord is used with this device make sure that the total of the ampere 
ratings of all products used on this cord does not exceed the extension cord 
ampere rating. Make sure that the total of all products plugged into the wall outlet 
does not exceed 15 amperes. 

•  To help protect your system from sudden, transient increases and decreases in 
electrical power, use a surge suppressor, line conditioner, or uninterruptible power 
supply (UPS).

•  Position system cables and power cables carefully; Be sure that nothing rests on 
any cables. 

•  Never push objects of any kind into or through cabinet slots. They may touch 
dangerous voltage points or short out parts resulting in a risk of fire or electrical 
shock. 

•  There is a risk of explosion if the battery is replaced by an incorrect type. Dispose 
of used batteries according to the instructions.

•  Use the power cords supplied with this package. If it becomes necessary to replace 
the cords supplied with this package, be sure to use cords of at least the same 
standard as the ones provided. Contact your dealer for information about power 
cords.

•  Do not attempt to service the device yourself. Refer all servicing to qualified service 
personnel.

Failure to follow these instructions can result in death or serious injury.
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Taking Delivery
Examine the components at the time of delivery to be sure all parts are present and in good working 
order. Anything missing or damaged must be reported immediately to the shipping firm and to APC.

Inventory

The package consists of: 

•  KVM Switch
•  NEMA 5 - 15 power cord
•  C13 - C14 power cord
•  Rack Mount Bracket
•  Serial Adapter (for modem connection) 
•  KVM Access Management Software USB key (please retain for future license upgrade)
•  Literature Kit: Quick Start Guide, Safety Sheet, China ROHS and CD (containing KVM Access 

Management software)

CAUTION
INJURY OR EQUIPMENT DAMAGE

•  Do not connect the RJ-11 connector marked “UPGRADE” to a public 
telecommunication network.

•  Before working on the rack, make sure that the stabilizers are secured to the rack, 
extended to the floor, and that the full weight of the rack rests on the floor. Install 
front and side stabilizers on a single rack or front stabilizers for joined multiple 
racks before working on the rack.

•  Always load the rack from the bottom up, and load the heaviest item in the rack 
first.

•  Make sure that the rack is level and stable before extending a device from the rack.
•  Use caution when pressing the device rail release latches and sliding a device into 

or out of a rack; the slide rails can pinch your fingers.
•  After a device is inserted into the rack, carefully extend the rail into a locking 

position, and then slide the device into the rack.
•  Do not overload the AC supply branch circuit that provides power to the rack. The 

total rack load should not exceed 80 percent of the branch circuit rating.
•  Make sure that all equipment used on the rack, including power strips and other 

electrical connectors, is properly grounded.
•  Ensure that proper airflow is provided to devices in the rack.
•  Ensure that the operating ambient temperature of the rack environment does not 

exceed the maximum ambient temperature specified for the equipment by the 
manufacturer

•  Do not step on or stand on any device when servicing other devices in a rack.
•  Do not place the device on an unstable surface. If the device falls, serious damage 

will result.
•  Do not block ventilation openings. Overheating of internal components may occur.
•  Route the power cord and cables so that they cannot be stepped on or tripped 

over.

Failure to follow these instructions can result in injury or equipment damage.
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System Requirements
Remote User Computers

Remote user computers (also referred to as client computers) are computers logged into the switch from 
remote locations over the internet. 
These computers must have the following equipment installed:

•  At least a PIII 1 GHz processor, with the screen resolution set to 1024 x 768.
•  Browsers must support 128 bit SSL encryption.
•  A network transfer speed of at least 512kbps.
•  For the browser-based WinClient ActiveX Viewer, DirectX 8 must be present, and at least 150MB 

of memory must be available after installation.
•  For the browser-based Java Applet Viewer the latest version of the Java Runtime Environment 

(JRE) must be installed, and at least 205MB of memory must be available after installation.
•  For the Windows Client AP, DirectX 8 must be present, and at least 90MB of memory must be 

available after installation.
•  For the Java Client AP, the latest version of the Java Runtime Environment (JRE) must be 

installed, and at least 145MB of memory must be available after installation.
•  For the Log Server, you must have the Microsoft Jet OLEDB 4.0 or higher driver installed.

Servers

Servers are the computers connected to the switch by KVM Adapter Cables. 
These servers must have the following equipment installed:

•  A VGA, SVGA or multisync port
•  For USB KVM Adapter Cable Connections: a Type A USB port and USB host controller
•  For PS/2 KVM Adapter Cable Connections: 6-pin Mini-DIN keyboard and mouse ports

Video

Only the following non-interlaced video signals are supported: 

Resolution Refresh Rates
640 x 480 60, 70, 72, 75, 85
720 x 400 70, 75
800 x 600 56, 60, 70, 72, 75, 85
1024 x 768 60, 70, 75, 85
1152 x 864 60, 70, 75, 85
1152 x 900 66, 76

1280 x 1024 60, 70, 75, 85, 
1600 x 1200 60
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KVM Server Modules and cables

Note: KVM server modules are also referred to as adapter cables in some dialog boxes..

•  Cat5e (or higher) cable connects the switch to the KVM server modules. 
•  The following KVM server modules and cables are required for use with the switch. 

Supported Operating Systems 

•  Microsoft Windows
•  Linux
•  UNIX
•  Mac
•  DOS

Browsers

Supported browsers for remote users: 

Cable Type Port Type
KVM-PS2 Connect to devices with PS/2 ports
KVM-PS2VM Connect to devices with PS/2 ports, virtual media support
KVM-USB Connect to devices with USB ports
KVM-USBVM Connect to devices with USB ports, virtual media support
KVM-USBVMCAC Connect to devices with USB ports, virtual media and smart card/CAC 

support
KVM-SERIAL Connect to serial based devices
AP5641  (Optional) Connect a rack PDU to the KVM

Browser Version
IE 6 and higher,
Chrome 8.0 and higher 
Firefox Windows 3.5 and higher 

Linux 3.0 and higher 
Safari Windows 4.0 and higher

Mac 3.1 and higher 
Opera 10.0 and higher 
Mozilla Windows 1.7 and higher 

Sun 1.7 and higher
Netscape 9.0 and higher 
5KVM Switch KVM2132P, KVM2116P, KVM1116P User Manual 



Max Server connections 

Parent 
KVM Model

Ports Child
Tiered KVM

Ports Servers in a Single 
Level Tier

Servers in a Two 
Level Tier

Maximum 
Levels

KVM2132P 32 KVM0216A * 16 32 x 16 x 16 = 8192 16 x 8 x 16 = 2048 3
KVM2116P 16 KVM0216A * 16 16 x 16 x 16 = 4096 8 x 8 x 16 = 1024 3
KVM1116P 16 KVM0116A * 16 16 x 16 = 256 2
KVM1116P 16 KVM0108A * 8 16 x 8 =128 2

* Not covered in this manual. See the User Manuals for these models for more information.
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Components
Front

Item Name Description
1 Power LED Illuminated when the unit is powered up and ready to operate.
2 Port LEDs Provides status information about corresponding KVM Ports.

• GREEN: The computer attached to the port is On Line.
• RED: The computer attached to the port is Selected (has KVM focus).
• GREEN + RED (ORANGE): The computer attached to the port is On Line and Selected.
The LEDs are continuously ON under normal conditions. An LED flashes at half second intervals 
when its corresponding port is accessed under Auto Scan Mode or Skip Mode.

3 LAN LEDs Primary and Secondary 10/100/1000 Mbps LAN LEDs.
• RED: 10 Mbps
• RED + GREEN (ORANGE): 100 Mbps
• GREEN: 1000 Mbps
Flashes to indicate that the switch is being accessed.

4 Reset Switch Use a small object like a paper clip or ballpoint pen to press the reset switch.
• To perform a system reset, press and release when the unit is running.
• To reset to the factory default settings, press and hold for +3 seconds when the unit is running.

Note: This does not clear User Account information. See “Factory Default Settings” on 
page 103, for information on clearing user account information. 

• To return to factory default firmware settings, rather than any upgraded version press and hold 
while powering on the unit. This allows recovery from a failed firmware upgrade so the upgrade 
may be tried again.
Note: This operation is only performed after a firmware upgrade failure that results in the 
device becoming inoperable.

5 Console Port A Rack LCD Console may be installed in this port.
6 USB Ports • Connect USB storage peripherals (CD/DVD, HD, flash drives, etc.).

• A USB keyboard and mouse can be used in place of, or in addition to, a keyboard and mouse 
plugged in on the rear panel. 
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Rear

Item Name Description

1 Power Socket 1 Plug power cable for Power Source 1 in here.

2 Power Socket 2 Plug power cable for Power Source 2 in here.

3 LAN Port(s) Connect the unit to the network interface (10/100/1000 Mbps) here

4
PDU Port(s) Connect to a PDU unit (which allows servers attached to the KVM switch to be booted 

remotely over the net).

5
Local Console Port(s) Local console devices (keyboard, monitor and mouse), plug in here. Any combination 

of USB and PS/2 keyboards and mice can be used.

6
KVM Ports Cat 5e cables plug in to link the unit to the KVM Adapter Cables, which connect to the 

servers.

7 Modem Port Dial in connection if the unit becomes unavailable over the network. 
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Installation

Overview
KVM Adapter Cables connect the switch to the connected devices. A separate KVM Adapter Cable is 
required for each server or device connection. See the list of KVM Adapter Cables on page 5 or contact 
APC Customer Support for help.

Note: 1. Refer to the Safety section of this manual before installing the KVM switch. 
2. Power to any device that will be connected to the installation must be turned off. Unplug 
the power cords of any computers that have the Keyboard Power On function.

Rack Mounting
The switch can be mounted in a 19" (1U) rack. The mounting brackets can screw into either the front or 
the back of the unit so that it can attach to the front or the back of the rack. 

Note: Use cage nuts (not provided) for racks that are not pre-threaded.

Rack Mounting - Front 

1. Position the switch in the front of the rack. 
Align the mounting bracket holes with the 
holes in the rack.

2. Secure the mounting brackets to the rack.
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Rack Mounting - Rear 

1. Remove the brackets from the front of the 
KVM switch. 
Remove the plug from the alignment hole.

2. Install the smaller bracket from the front of 
the unit to the back. Install the rack mounting 
bracket from the inventory to the rear of the 
unit.

3. Slide the switch into the rack. Align the 
mounting bracket holes with the holes in the 
rack.

4. Secure the mounting brackets to the rear of 
the rack.

Optional KVM to LCD Console Mounting 
The KVM switch can be mounted to a Rack LCD Console (not included). See the installation sheet for 
the Rack LCD Console KVM switch bracket kit for more information. 
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Single Level Installation
In a single level installation, no additional switches are tiered from the original switch. 

1. Plug the keyboard, monitor, and mouse of your Local Console into the Console Ports of the KVM 
parent switch. Each port is color coded and marked with an appropriate icon. 

Note: 1. Any combination of keyboard and mouse connections can be used. 
2. USB keyboards and mice can be plugged into the USB ports on the front panel or 
into the console ports on the back.

2. Use Cat 5e cable to connect a KVM port to a KVM server module appropriate for the server 
being installed.

3. Plug the connectors on the KVM server module into the appropriate server ports.
4. Plug a cable from the LAN or WAN into the KVM switch's primary network interface socket.
5. (Optional) Plug another cable from the LAN or WAN into the KVM switch's backup (secondary) 

network interface socket.
6. (Optional) Use Cat 5e cable to connect the switch's Modem port to an SA0142 Serial Adapter. 

Connect the Adapter's serial connector to the modem's DB-9 port.

7. Plug the supplied power cord(s) into the switch's power socket(s), then into an AC power source.
8. Turn on the servers.

KVM1116P Single Level Installation Diagram 
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KVM2132P Single Level Installation Diagram 

Note: KVM2116P Single Level Installation is the same except for the number of KVM 
ports.
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Tiering Multiple KVM Switches 
A tiered installation will greatly expand the number of servers that can be added to the installation. 
Cascaded tiering adds capacity to a KVM installation, but the parent loses at least one KVM port for 
each tiered KVM switch. KVM2132P, and KVM2116P support tiering up to 3 levels. When the KVM 
consoles of the first-level KVM switch invoke the OSD, all computers on the tiered KVM installation 
are listed in the port directory.

KVM1116P Two Level Installation 

Up to 16 additional KVM switches can be tiered from the KVM ports of the original KVM switch. As 
many as 256 servers can be controlled in a complete two level installation. In a tiered installation, the 
(KVM1116P) switch is considered the First Level or Parent unit, the tiered switches are considered 
Second Level or Child units (KVM0116A / KVM0108A) . Turn off power to all the devices, including 
all pre-existing devices on the installation.

1. Use Cat 5e cable to connect any available KVM Port on the First Level unit (KVM1116P) to a 
KVM-PS2 Adapter Cable.

2. Plug the adapter cable's KVM connectors to the Keyboard, Video, and Mouse Console ports of 
the Second Level switch (KVM0116A / KVM0108A).

3. Connect any available KVM port on the Second Level unit to the Keyboard, Video, and Mouse 
ports of the server.

4. Power on the First Level switch, then power on the Second Level switches .
5. Turn the servers on last.

Two Level Installation Diagram

* See the User Manual for KVM0116A and KVM0108A for more information about this unit.
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Three Level Installation and (1 or 2) Bus Configurations

In tiered installations, the number of bus connections between a parent and child KVM switch 
determines the number of users that can simultaneously access the KVM ports of a child switch. A bus 
connection is established by connecting a KVM port on the parent switch to a LAN port on the child 
switch. The KVM switch (KVM2132P, KVM2116P) supports a maximum of two bus connections for 
each tiered switch.

In a two-bus tiered configuration, two bus connections between every parent switch and child switch in 
the installation are created so both KVM consoles on the first-level KVM switch can access the KVM 
ports of any tiered switches at the same time. Console connectors of the child switches are inoperable.

In a one-bus tiered configuration only a single bus connection is created between a parent switch and a 
child switch. Only one of the consoles connected to the parent switch has access to a child switch at any 
time. The second console can still control and access the ports of the parent switch. Only one console of 
each child switch is available to access the KVM ports on the same level or lower level switch. KVM 
consoles connected to tiered switches cannot access the ports of a parent switch and can perform only 
port switching and user profile changes. No other administrative functions can be executed.

KVM2132P / KVM2116P Two busTiered Diagram

* See the User Manual for KVM0216A for more information about this KVM switch.

KVM2132P (or KVM2116P)

KVM0216A *
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KVM0216A *
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KVM1116P One Bus Tiered Diagram

* See the User Manual for KVM0116A and KVM0108A for more information about these KVM switches.

Hardware Setup
Cable Length Considerations

Note: KVM server modules are also referred to as KVM adapter cables.

•  Do not exceed 66 feet (20m) between the switch and the local monitor.
•  The distance between the First Level (Parent) KVM switch and the Second Level (Child) KVM 

switch must not exceed 93 feet (30m). 
•  To support a resolution of 1280x1024, the recommended maximum distance between the KVM 

switch and the KVM server module is 164 feet (50m).

•  The total distance between any KVM switch and any KVM server module in the installation 
cannot exceed 164 feet (50m).

Hot Plugging

The KVM switch supports hot plugging. Components can be removed and added by unplugging and re-
plugging cables from the ports without shutting the unit down.

Note: The Operating System of the server must support hot plugging for this function to 
work properly.

ae
m0

37
6a

KVM1116P

KVM0116A *
KVM-PS2
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The Adapter ID Function 

Server module information (the Adapter ID, port name, OS, keyboard language, and access mode) is 
stored on the server module. The switch's Adapter ID function stores this information along with the 
server module's configuration information (access rights, etc.), so that when a server is moved with its 
server module from one port to another, its settings do not have to be reconfigured. The Adapter ID 
function restores them at the new location. Only the port number changes.

When moving the server and server module cable to another switch, only the information that is stored 
on the server module is retained. Other settings must be reconfigured, or the Backup/Restore function 
can be used (see page 93).

Port settings are stored with the server module. If a server is moved to a new port without its original 
server module, or if a different server is connected to the server module, the port settings for the new 
server must be manually configured. See “Sidebar Utilities” on page 38 for port configuration details.

Powering Off and Restarting

If the switch is powered off, or if the switch loses power and needs to be restarted, wait 10 seconds 
before powering it back on. Servers should not be affected, but if any fail, restart them.

Port ID Numbering

Each server on the installation is assigned a unique Port ID.

1. A server attached to a first level KVM switch has a one segment Port ID that corresponds to the 
KVM Port number to which it is connected. 

2. A server attached to a Second Level KVM switch has a two segment Port ID.
a. The first segment represents the First Level unit’s KVM Port number that connects to the 

Second Level KVM unit.
b. The second segment represents the Second Level unit’s KVM Port number that connects to 

the server.
Example: A Port ID of 12 - 3 refers to a server connected to KVM Port 3 of a Second Level unit (child) 
connected to KVM Port 12 of the First Level unit (parent).

A server attached to a third level KVM switch has a three segment Port ID. Example: 12-03-05.

Port Selection

Port selection is accomplished by means of the GUI. See Port selection details on page 37.

PDU Connection (KVM2132P, KVM2116P)

•  Connect the PDU and KVM switch with connection cable AP5641.
•  The RJ12 connector plugs into the PDU port labeled “Serial”.
•  The RJ45 connector plugs into the KVM port labeled “PDU1” or “PDU2”.
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Super Administrator Setup
Overview
First Time Setup

The Super Administrator sets up the unit for user operation (set the network parameters, change the 
default Super Administrator login) for the first time from the local console if possible. See “IP Address 
Determination” on page 105 to set up remotely.

Since this is the first time you are logging in, use the default Username “apc” and Password “apc”. The 
Local Console Main Page will open following a successful login.

Note: For security purposes, changing to a unique Username and Password is recommended.

Network Setup
1. Click the Device Management tab.
2. Select the Network tab.
3. Fill in the fields according to the information provided under Network, page 68.

Changing the Super Administrator Login 

1. At the top of the screen, click the User tab. 
The page lists Users and Groups in the Sidebar at the left, and more details in the center panel. 
The first time the page is accessed, only the Super Administrator appears.
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2. Click on Administrator in the left panel or select Administrator in the central panel.
Click Modify at the bottom of the page to open the User Information page.

3. Change the Username and Password.
4. Enter the new password again in the Confirm Password field and click Save.
5. Click OK in the dialog box that says the change completed successfully.
6. Click on another item on the Local Console Main Page, to close the User Information page.
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Logging In

Overview
Switches can be accessed from a local console, an internet browser, a Windows application (AP) 
program, and a Java application (AP) program.

The switch's authentication procedure requires a valid username and password. Invalid login information 
will open an Invalid Username or Password, or Login Failed message. 

Note: If the login fails, log in again with a correct username and password. If the number of 
invalid login attempts exceeds a specified amount, a timeout period is invoked. The timeout 
period must expire before another login is attempted. See Login Failures, page 75.

Local Console Login
Enter your Username and Password, then click Login to open the Local Console Main Page. The Local 
Console Main Page is similar to the Web Browser, WinClient and Java Client Main Pages. For a 
description of the Web Browser Main Page, see page 22.

Browser Login
The switch can be accessed from an Internet browser running on any platform. 

1. Specify the IP address of the switch you want to access in the browser's address bar.
Note: If the administrator added a login string for security purposes, include a 
forward slash and the login string along with the IP address when you log in. 

2. When a Security Alert dialog box opens, accept the certificate. It can be trusted. If a second 
certificate appears, accept it as well to open the login page.

3. Provide your username and password and click Login to open the Web Main Page. 
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Windows Client AP Login
The Windows AP Client allows direct remote access to Windows systems users, without going through a 
browser although initially the Windows AP Client program must be downloaded from the browser page.

Double-click the WinClient.exe icon to open the Windows Client Connection Screen:

The Windows Client AP Connection Screen

Connect using Windows Client AP

1. Select the device from the Server List box and double-click on it or specify its IP address and port 
number in the Server IP and Port input boxes.

2. Click Connect to open the Login dialog box.
3. Enter a valid Username and Password, and click OK.
4. Following authentication, the Switch to Remote View button becomes active. Click it to connect 

to the switch and bring up its GUI Main Page. 

The File Menu

Create, Save, and Open user created Work files. A Work File consists of all the information specified in 
a Client session including the Server List, Server IP list items, and Hotkey settings. The Client program 
opens with the values contained in the current work file. The current work file consists of the values that 
were in effect the last time the program was closed. 

Item Description
Menu Bar The Menu Bar contains two items: File and Help.

• The File Menu allows the operator to Create, Save, and Open user created Work files.
• The Help Menu displays the WinClient AP version.

Server List WinClient.exe searches the user's local LAN segment for switches, and lists them in this 
box. Double-click to connect to one of these units.
Note: 1. The switch’s Enable Device List configuration parameter must be enabled. 
2. Units in the Server List are those whose Access Port settings match the number 
specified for Port in the Server area of this dialog box.

Server Used when connecting to a switch at a remote location. Select an address from the IP list 
box. If the address isn't listed, enter the target IP address in the IP field, and its port 
number in the Port field. If you don't know the port number, contact your Administrator.
• When the IP address and Port number have been specified, click Connect. 
• When finished, return to this dialog box and click Disconnect to end the connection.

Message Panel Lists status messages regarding the connection to the switch.
Switch to Remote View Click to switch to the GUI Main Page (page 23). 

New Create a named work file so its values will not be lost, and it will be available for future recall.
Open Open a previously saved work file and use the values contained in it.
Save Save the values presently in effect as the current work file.
Exit Exits the WinClient.
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Java Client AP Login
The Java AP Client provides direct remote access to non-Windows systems users although the Java AP 
Client program is initially downloaded from the browser page. Double-click the JavaClient.jar icon to 
open the Java Client Connection Screen. 

Connect using - Java Client AP

To connect to a KVM switch:

1. Select the device from the Server List box and double-click on it or specify its IP address and port 
number in the Server IP and Port input boxes.

2. Click Connect to open the Login dialog box.
3. Enter a valid Username and Password, and click OK.
4. Following authentication, the Switch to Remote View button becomes active. Click it to connect 

to the switch and open its GUI Main Page. 

Item Description
Server List  JavaClient.jar searches the user's local LAN segment for KVM switches, and lists them 

in this box. Double-click to connect to one of these units. 
Note: 1. The switch’s Enable Device List configuration parameter must be enabled. 
2. Units in the Server List are those whose Access Port settings match the number 
specified for Port in the Server area of this dialog box.

Server Used when connecting to a switch at a remote location. Select an address from the IP list 
box. If the address isn't listed, enter the target IP address in the IP field, and its port 
number in the Port field. If you don't know the port number, contact your Administrator.
• When the IP address and Port number have been specified, click Connect. 
• When finished, return to this dialog box and click Disconnect to end the connection.

Message Panel Lists status messages regarding the connection to the switch.
Switch to Remote View Click this button to switch to the GUI Main Page. 
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The User Interface
Overview

The look of the user interface Main Page varies depending on the method used to log in. 

The Web Browser Main Page 
Access the KVM switches with most standard web browsers. Once users log in and are authenticated, the 
Web Browser Main Page opens with the Port Access page displayed.

Note: Depending on a user's type and permissions, not all elements appear.

Item Description
Tab Bar Contains the KVM switch's main operation categories. Items appearing in the tab bar are 

determined by user type, and authorization options.
Menu Bar Contains operational sub-categories related to the selected item in the tab bar. Items in the 

menu bar are determined by user type, and authorization options.
Sidebar Provides a tree view listing of ports related to the tab bar and menu bar selections. Click an 

item in the Sidebar to open a detail page. Expand or narrow the scope of the ports that 
appear in the tree by clicking the Filter button at the bottom of the Sidebar. See the Filter 
function on page 40 for details.

About Provides information regarding the switch's current firmware version.
Logout Click this button to log out of your KVM switch session.
Welcome Message If enabled (see Welcome Message*, page 112), a welcome message displays here.
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The Tab Bar

The number and type of icons that appear on the Tab Bar at the top of the page are determined by user 
type (Super Administrator, Administrator, User) and permissions. 

There are two small icons at the extreme right of the page. 

The AP GUI Main Page 
The GUI Main Page is similar to that of the Web Browser. The differences are:

1. The AP GUI version does not have a menu bar below the tab bar. It has tabs like a notebook. Like 
the Web Browser interface, the makeup of the tabs changes depending on the items selected on 
the main Tab Bar and in the Sidebar.

2. In addition to Filter, there are also buttons for Scan and Array Mode at the bottom of the Sidebar. 
See “Port Access” on page 37 for more information.

3. There is a hidden Control Panel at the upper (default position) or lower center of the screen that 
becomes visible when the mouse is moved over it. 

4. There is an additional icon at the extreme right of the page. Click this icon to close the GUI Main 
Page and go to the display of the last selected port.

Interactive Display Panel The main work area. The screens reflect menu choices and Sidebar item selection.

Icon Description
Port Access: The Port Access page is used to access and control the devices on the KVM switch 
installation. This page is available to all users.

 Create and manage Users and Groups, also assign devices to them. This tab is available to the Super 
Administrator, administrators, and users who have User Management permission. The tab does not 
appear for other administrators and users.
Configure and control the overall operation of the KVM switch. This page is available to the Super 
Administrator, administrators, and users who have Device Management permission. The tab doesn't 
appear for other administrators and users.
Displays the contents of the log file.

Install new firmware; backup and restore configuration and account information; ping network 
devices; and restore default values. This page is available to the Super Administrator (and 
Administrators and Users with Maintenance permission). The icon doesn't display on the page of 
ordinary administrators and users.
Download AP versions of the Windows Client, the Java Client, and the Log Server. This page is 
available to all users. The programs that can be downloaded depend on the user's permissions.

Icon Description
Click the About icon to see information about the KVM switch firmware version.

Click the Logout icon to log out and end your KVM switch session.
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5. The GUI can be navigated via the keyboard. 

The Local Console GUI Main Page
The main difference between the Local Console GUI Main Page and the Java and Windows AP GUI 
Main Page is the Local Console Main Page does not have a tab for Download.

The Control Panel
The WinClient Control Panel (for the ActiveX Web Viewer and WinClient AP) contains the most 
complete functionality. This section describes the WinClient Control Panel. 

The Java Control Panel (for the Web Viewer and Java Client AP) does not enable all of the features that 
the WinClient Control Panel enables. The features that are common to both panels also function 
similarly. 

The Control Panel is hidden at the upper (the default position) or lower center of the screen, and becomes 
visible when the mouse moves over it. The panel consists of three rows: an icon row at the top, and two 
text rows below. 

Note: The icons that appear can be user selected. See “Control Panel Configuration” on 
page 35, for details.

•  By default, the upper text row shows the video resolution of the remote display. As the mouse 
pointer moves over the icons, the information in the upper text row changes to describe the icon's 
function. If a message from another user is entered in the message board, and the message board 
has not been opened, the message will appear in the upper row.

Keys Action
Ctrl + P Opens the Port Access page.
Ctrl + U Opens the User Management page.
Ctrl + C Opens the Device Management page.
Ctrl + L Opens the Log page.
Ctrl + M Opens the Maintenance page.
Ctrl + D Opens the Download page.
F1 To see About information
F2 To edit the port name of the selected port
F4 Selects the Sidebar (left) panel.
F5 Selects the main (right) panel
F7 Closes the GUI.
F8 To log out.
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•  The lower row shows the IP address of the device you are accessing at the left of the row. The 
center of the row indicates which bus the user is on (the number before the slash), and the total 
number of users on that bus (the number behind the slash).

Note: Bus and user information only display if enabled. 

•  Right click in the text row area to open a menu-style version of the toolbar. Select options for the 
Screen Mode, Zoom, Mouse Pointer type, and Mouse Sync Mode. 

•  To move the Control Panel to a different location on the screen, move the mouse pointer over the 
text row area, then click and drag.
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WinClient Control Panel Functions 

Icon Function
Toggle icon. Click to make the Control Panel always display on top of other screen 
elements. Click again to have it display normally.

Macro icon.Click to open the Macros dialog box (see page 30 for details).

Hammer icon. Click to open the Video Options dialog box. Right-click to perform a quick 
Auto Sync (see “Video Settings” on page 30 for details).

Click to perform a video and mouse autosync operation. It is the same as clicking the 
Auto-sync button in the Video Options dialog box (see “Video Settings” on page 30).

Toggle the display between Full Screen Mode and Window Mode.

Click to take a snapshot (screen capture) of the remote display. See “Snapshot” on 
page 35 for details.

Click to open the Message Board (see “The Message Board” on page 31).

Click to send a Ctrl+Alt+Del signal to the remote system.

Click to toggle the remote display between color and gray scale views.

Click to open the Virtual Media dialog box. See “Virtual Media” on page 32 for details. 
Note: 1. This icon is displayed on the switches only. 
2. This icon displays in gray when the function is disabled or not available.
Click to zoom the remote display window. 
Note: This feature is only available in windowed mode (Full Screen Mode is off). See 
“Zoom” on page 33 for details.
Click to open the on-screen keyboard (see “The On-Screen Keyboard” on page 33).

Click to select the mouse pointer type. 
Note: This icon changes depending on which mouse pointer type is selected (see “Mouse 
Pointer Type” on page 34)
Click to toggle Automatic or Manual mouse sync.
• When the selection is Automatic, a green V appears on the icon.
• When the selection is Manual, a red X appears on the icon.

See “Mouse DynaSync Mode” on page 34 for details.

Click to open a list of User macros in order to access and run macros more conveniently 
than using the Macros dialog box.

Under an accessed port, click to skip to the first port accessible to the user on the entire 
installation without going to the Port Access page.

Under an accessed port, click to skip to the first port accessible to the user that is previous 
to the current one without going to the Port Access page.

Under an accessed port, click to skip to the first port accessible to the user that is after the 
current one without going to the Port Access page.
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Macros 

There are three functions in the Macros dialog box: Hotkeys, User Macros, and System Macros. 

Hotkeys. The Hotkey Setup utility (accessed by clicking the icon), lets you configure which hotkeys 
perform actions. The hotkeys that invoke an action are shown to the right of its name. Click to put a 
check in the checkbox to the left of an action's name to enable or disable its hotkey.

To change the hotkey for an action:

1. Highlight the Action, then click Set Hotkey.
2. Press your selected Function keys (one at a time). The key names appear in the Hotkeys field as 

you press them. 
a. The same function keys can be used for more than one action, as long as the key sequence 

is not the same. 
b. To cancel setting a hotkey value, click Cancel. To clear an action's Hotkeys field, click 

Clear.
3. When you have finished entering your sequence, click Save. To reset all the hotkeys to their 

default values, click Reset.

Under an accessed port, click to skip to the last port accessible to the user on the entire 
installation without going to the Port Access page.

Under an accessed port, click to begin Auto Scan Mode. The KVM switch automatically 
switches among the ports selected for Auto Scanning with the Filter function (see Filter, 
page 40). Monitor the activity of the ports without switching through them manually.
Under an accessed port, click to invoke Panel Array Mode (see “Panel Array Mode” on 
page 88).

Under an accessed port, click this icon to select the Adapter cable (Short, Medium, Long) 
that connects the device to the switch. The length of the line in the icon indicates the 
selection. 
Under an accessed port, click to recall the GUI.

Click to open the Control Panel Configuration dialog box. See “Control Panel 
Configuration” on page 35, for more information.

Click to exit the viewer.
• Exit from a Browser Viewer session brings you back to the web browser Main Page.
• Exit from a WinClient AP session brings you back to the login dialog box.
• Exit from a Java Client AP session brings you back to the login dialog box.
These icons show the Num Lock, Caps Lock, and Scroll Lock status of the remote 
computer.
• When the lock is On, the LED is bright green and the lock hasp is closed.
• When the lock is Off, the LED is dull green and the lock hasp is open. 

Click on the icon to toggle the status.
Note: These icons and your local keyboard icons are in sync. Press a Lock key on your 
keyboard and the icon changes accordingly.
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Hotkey actions: 

User Macros. User Macros perform specific actions on the remote server. 
To create the macro:

1. Select User Macros, then click Add.
2. Replace the “New Macro” text in the dialog box with a name of your choice for the macro.
3. Click Record. The dialog box closes, and a small panel opens at the top left of the screen.
4. Press the keys for the macro. 

a. To pause macro recording, click Pause. To resume, click Pause again. 
b. Clicking Show opens a dialog box that lists each keystroke that you make, together with the 

amount of time each one takes:
c. Click Cancel to cancel all keystrokes.
d. When you have finished, click Stop. (This is the equivalent of clicking Done in Step 5.)

Note: 1. The function is not case-sensitive. 
2. When recording the macro, the focus must be on the remote screen not the macro 
dialog box. 
3. Only the default keyboard characters may be used. 

5. If the Show dialog box has not been opened, click Done when you have finished recording your 
macro. The screen returns to the Macros dialog box with system macro key presses displayed in 
the Macro column

6. To change keystrokes, select the macro and click Edit. This dialog box is similar to the one for 
Show. Keystrokes, order, etc. can be changed.

Action Explanation
Exit remote location Breaks the connection to the KVM switch and returns you to local client computer 

operation. This is equivalent to clicking the Exit icon on the Control Panel. The default 
keys are F2, F3, F4.

Adjust Video Opens the Video Settings dialog box. This is equivalent to clicking the Video Settings icon 
on the Control Panel. The default keys are F5, F6, F7.

Toggle Control Panel Toggles the Control Panel Off and On. The default keys are F3, F4, F5.
Toggle mouse display If the display of the two mouse pointers (local and remote) is confusing or annoying, shrink 

the non-functioning pointer down to a tiny circle, which can be ignored. This function is a 
toggle. Use the hotkeys to bring the mouse display back to its original configuration. This is 
equivalent to selecting the Single pointer type from the Mouse Pointer icon on the Control 
Panel. The default keys are F7, F8, F9.
Note: The Java Control Panel does not have this feature.

Adjust mouse This synchronizes the local and remote mouse movements. The default keys are F7, F8, F9.
Video Auto-sync This combination performs an auto-sync operation. It is equivalent to clicking the Video 

Autosync icon on the Control Panel. The default keys are F8, F7, F6.
Show/Hide Local 
Cursor

Toggles your local mouse pointer off and on. This is equivalent to selecting the Null pointer 
type from the Mouse Pointer icon on the Control Panel. The default keys are F4, F5.

Substitute Ctrl key If your local computer captures Ctrl key combinations, preventing them from being sent to 
the remote server, implement their effects on the remote server by specifying a function key 
to substitute for the Ctrl key. Example: Substituting the F11 key, pressing [F11 + 5] would 
appear to the remote server as [Ctrl + 5]. The default key is F11.

Substitute Alt key In order to implement [Alt + Tab] and [Ctrl + Alt + Del] effects on the remote server, 
another key is substituted for the Alt key. Substituting the F12 key, for example, you would 
use [F12 + Tab] and [Ctrl + F12 + Del]. The default key is F12.
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Three ways to run macros:

1. Use the assigned hotkey.
2. Click on the macro from the Macro List on the Control Panel.
3. Open the Macros dialog box and click Play. 

Run the macro from the Macros dialog box to have the option of specifying how the macro runs.
– Click Play Without Wait to run the keypresses one after another with no time delay between 

them.
– Click Play With Time Control and wait for the amount of time between key presses that you 

took when you created the macro. Click on the arrow next to Play to choose.
– Click Play without opening the list to run with the default choice (NoWait or TimeCtrl), which 

is shown in the Playback column. Change the default choice by clicking on the current choice 
and selecting the alternate choice.
Note: User Macros are stored on the Local Client computer of each user. 
There is no limit on the of number of macros, the size of the macro names, or makeup of the 
hotkey combinations.

Click the Search button at the bottom of the dialog box to filter the list of macros in the upper panel to 
play or edit. Click a radio button to choose whether to search by name or by key. Enter a string for the 
search, then click Search. All instances that match the search string appear in the upper panel.

System Macros. System Macros are used to create exit macros for closing a session. 
Example: As an added measure of security, create a macro that sends the Winkey-L combination which 
will cause the remote server's log in page to open the next time the device is accessed. To create the 
macro:

1. Select System Macros, then click Add.
2. In the dialog box, replace the “New Macro” text with a name for the macro.
3. Click Record to close the dialog box, and open a small panel at the top left of the screen:
4. Press the keys for the macro.

a. To pause macro recording, click Pause. To resume, click Pause again.
b. Click Show to open a dialog box listing each keystroke that you make, together with the 

amount of time each one takes.
5. If Show has not been opened, click Done when you have finished recording your macro. Return 

to the Macros dialog box and the system macro key presses display in the Macro column
6. To change keystrokes, select the macro and click Edit. A dialog box similar to the one for Show 

opens. Keystrokes, order, etc. can be changed.
Once system macros have been created, they are available for use on a port-by-port basis. Select them on 
a port's Port Configuration > Port Properties page.
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Video Settings 

Clicking the Hammer icon on the Control Panel brings up the Video Settings dialog box. Adjust the 
placement and picture quality of the remote screen on your monitor with these options.

Options Usage
Screen Position Adjust the horizontal and vertical position of the remote server window by clicking the 

Arrow buttons.
Auto-Sync Click to have the vertical and horizontal offset values of the remote screen detected and 

automatically synchronized with the local screen.
Note: 1. If the local and remote mouse pointers are out of sync, in most cases, performing 
this function will bring them back into sync. 
2. This function works best with a bright screen. 
3. If the results are unsatisfactory, use the Screen Position arrows to position the remote 
display manually.

RGB Drag the slider bars to adjust the RGB (Red, Green, Blue) values. When an RGB value is 
increased, the RGB component of the image is correspondingly increased. If you enable 
Set to Grayscale, the remote video display is changed to grayscale.

Gamma This section allows you to adjust the video display's gamma level. 
Network Type Select the type of internet connection that the local client computer uses. The switch will 

use that selection to automatically adjust the Video Quality and Detect Tolerance settings 
to optimize the quality of the video display.
Since network conditions vary, if none of the pre-set choices work well, select Customize 
and use the Video Quality and Detect Tolerance slider bars to adjust the settings to suit 
your conditions.

Video Quality Drag the slider bar to adjust the overall Video Quality. The larger the value, the clearer the 
picture and the more video data goes through the network. Depending on the network 
bandwidth, a high value may adversely effect the PDU response time.

Enable Refresh Select Enable Refresh and enter a number from 1 through 99. The KVM switch will 
refresh the screen at the interval specified. This feature is disabled by default. Click to put 
a check mark in the box next to Enable Refresh to use this feature.
Note: 1. The switch starts counting the time interval when mouse movement stops.
2. Enabling this feature increases the volume of video data transmitted over the network. 
The lower the number specified, the more often the video data is transmitted. Setting the 
value too low may adversely affect PDU response.

Transparency Adjusts toolbar transparency when the GUI hotkey is invoked. Slide the bar until the 
display in the example window is satisfactory.

Color Depth Control This setting determines the richness of the video display by adjusting the amount of color 
information.

Detect Tolerance This setting governs detecting or ignoring pixel changes. A high setting can result in a 
lower quality display due to less data transfer. A lower setting will result in better video 
quality. Setting the threshold too low may allow too much data to be transferred, negatively 
impacting network performance.
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Gamma Adjustment. If it is necessary to correct the gamma level for the remote video display, use the 
Gamma function of the Video Adjustment dialog box.

•  Under Basic configuration, there are ten preset and four user-defined levels to choose from. 
Choose the most suitable one from the list. 

•  For greater control, click the Advanced button to open the dialog box
•  Click and drag the diagonal line at as many points as needed for the display output desired.
•  Click Save As to save up to four user-defined configurations. Saved configurations can be opened 

from the list box.
•  Click Reset to abandon any changes and return the gamma line to its original position.
•  Click OK to save your changes and close the dialog box.
•  Click Cancel to abandon your changes and close the dialog box.

Note: For best results, change the gamma while viewing a remote server.

The Message Board 

A message board has been provided for users to communicate and to alleviate access conflicts. 
The buttons on the Button Bar are toggles. Their actions are described in the table below:

Message Display Panel. Messages that users post to the board as well as system messages display in 
this panel. If Chat is disabled, messages posted to the board will not appear.

Compose Panel. Enter the messages in this panel. Click Send, or press [ENTER] to post the message to 
the board.

User List Panel. The names of all the logged in users are listed in this panel.

•  Your name appears in blue. Other users' names appear in black.
•  By default, messages are posted to all users. To post a message to one individual user, select the 

user's name before sending your message.
•  If a user's name is selected, and you want to post a message to all users, select All Users before 

sending your message.
•  If a user has disabled Chat, the icon displays before the user's name.
•  If a user has occupied the KVM, its icon displays before the user's name.

Button Action
Enable/Disable Chat. When disabled, messages posted to the board are not displayed. The button is 
shadowed when Chat is disabled. The icon displays next to the user's name in the User List panel 
when the user has disabled Chat.

Occupy/Release Keyboard/Video/Mouse. When you Occupy the KVM, other users cannot see the 
video, and cannot input keyboard or mouse data. The button is shadowed when the KVM is occupied. 
The icon displays next to the user's name in the User List panel when the user has occupied the KVM.

Occupy/Release Keyboard/Mouse. When you Occupy the KM, other users can see the video, but 
cannot input keyboard or mouse data. The button is shadowed when the KVM is occupied. The icon 
displays next to the user's name in the User List panel when the user has occupied the KVM.

Show/Hide User List. When you Hide the User List, the User List panel closes. The button is 
shadowed when the User List is open.
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Virtual Media 
The Virtual Media feature allows a drive, folder, image file, or removable disk on a user's system to 
appear and act as if it were installed on the remote server.

Note: 1. Virtual Media is only supported on remote servers that use the specified adapter 
cables. 2. The Virtual Media icon changes depending on the status of the virtual media 
function. 

Mounting Virtual Media. To mount a virtual media device:

1. Click the Virtual Media icon to open the Virtual Media dialog box.
Note: The T button at the top right opens a slider bar to adjust the transparency of the 
dialog box. After making your adjustment, click anywhere in the dialog box to 
dismiss the slider.

2. Click Add, then select the media source. Additional dialog boxes open to enable selection of the 
drive, file, folder, or removable disk. See “Virtual Media Support” on page 105 for a list of 
supported virtual media types.

3. If your device only supports full speed USB, put a check in the Disable High Speed USB 
Operation Mode checkbox.

4. To add additional media sources, click Add, and select the source as many times as required. Up 
to three virtual media choices can be mounted. The top three in the list are the selected sources. 
To rearrange the selection order, highlight the device to be moved, then click the Up or Down 
Arrow button to promote or demote it in the list.

5. Read refers to the redirected device being able to send data to the remote server. Write refers to 
the redirected device being able to have data from the remote server written to it. For the 
redirected device to be writable as well as readable, click to put a check in the Enable Write 
checkbox. If a redirected device cannot be written to, it appears in gray.

6. To remove an entry from the list, select it and click Remove.
7. After you have made your media source selections, click Mount and the dialog box closes. The 

virtual media devices that you have selected are redirected to the remote server where they show 
up as drives, files, folders, etc. on the remote server's file system. 
Once mounted, you can treat the virtual media as if they really existed on the remote server. Drag 
and drop files to or from them, open files on the remote server for editing, and save them to the 
redirected media. 
Files that you save to the redirected media will actually be saved on your local client computer's 
storage. Files that you drag from the redirected media will actually come from your local client 
computer's storage.

8. To end the redirection, open the Control Panel and click on the Virtual Media icon. All mounted 
devices are automatically unmounted.

Button Action
The icon displays in gray to indicate that the virtual media function is disabled or not available

The icon displays in blue to indicate that the virtual media function is available. Click the icon to 
bring up the virtual media dialog box.

The icon displays in blue with a red X to indicate that a virtual media device has been mounted on 
the remote server. Click the icon to unmount all redirected devices.
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Zoom 
The Zoom icon controls the zoom factor for the remote view window. 

The On-Screen Keyboard 
The KVM switch supports an on-screen keyboard, available in multiple languages, with all the standard 
keys for each supported language. Click the icon to open the on-screen keyboard. 

If the keyboard languages of the remote and local systems are not the same, the configuration settings for 
either system do not have to be changed. Open the on-screen keyboard, select the language used by the 
server being accessed, and use the on-screen keyboard to communicate with it. You must use your mouse 
to click on the keys. You cannot use your actual keyboard.

Changing Languages. 

1. Click the Down arrow next to the currently selected language to open the language list.
2. Select the new language from the list.

Selecting Platforms. The On-screen Keyboard supports the Sun platform as well as the PC. 
To select the platform:

1. Click the Down arrow next to the currently selected platform to open the platform list.
2. Select the new platform from the list.

Expanded Keyboard. To display or hide the expanded keyboard keys, click the arrow to the right of 
the language list arrow.

Setting Description
100% Sizes and displays the remote view window at 100%.
75% Sizes and displays the remote view window at 75%.
50% Sizes and displays the remote view window at 50%.
25% Sizes and displays the remote view window at 25%.
1:1 Sizes and displays the remote view window at 100%. The difference between this setting and the 

100% setting is that when the remote view window is resized, its contents don't resize. They 
remain at the size they were. To see any objects that are outside of the viewing area move the 
mouse to the window edge, to have the screen scroll.
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Mouse Pointer Type 
The KVM switch offers several mouse pointer options when working in the remote display. Click the 
icon to select from the available choices.

Note: 1. Before accessing a port, only Dual and Crosshairs are available for the Windows 
Viewers. Once the port is accessed, all four pointers are available.
2. The Dot pointer is not available with the Java Applet Viewer or the Java Client AP.
3. Selecting the Dot pointer has the same effect as the Toggle mouse display hotkey function 
(see “Toggle mouse display” on page 28 for details).
4. The icon on the Control Panel changes to match your choice.

Mouse DynaSync Mode 
Synchronization of the local and remote mouse pointers is accomplished either automatically or 
manually.

Automatic Mouse Synchronization (DynaSync). Mouse DynaSync provides automatic locked-in 
synching of the remote and local mouse pointers. 

Note: This feature is only available for Windows and Mac systems (G4 and higher) whose 
adapter attribute OS setting is configured for Win or Mac (see “Port Properties” on page 39), 
which are connected to the switch with one of the specified Adapter Cables. All other 
configurations must use manual mouse synchronization.

The icon on the Control Panel indicates the synchronization mode status. 

•  The icon displays in gray to indicate that Mouse DynaSync is not available - you must use manual 
synching procedures. This is the default setting.

•  The green check mark on this icon indicates that Mouse DynaSync is available and is enabled. 
This is the default setting when Mouse DynaSync is available.

•  The red X on this icon indicates that Mouse DynaSync is available but is not enabled.
When Mouse DynaSync is available, clicking the icon toggles its status between enabled and disabled. If 
you choose to disable Mouse DynaSync mode, you must use the manual synching procedures.

Mac and Linux Considerations. 

•  For Mac OS versions 10.4.11 and higher, there is a second DynaSync setting to choose from. If 
the default Mouse DynaSync result is not satisfactory, try the Mac 2 setting. To select Mac 2, right 
click in the text area of the Control Panel and select Mouse Sync Mode > Automatic for Mac 2.

•  Linux doesn't support DynaSync Mode, but there is a setting on the Mouse Sync Mode menu for 
Redhat AS3.0 systems. If you are using a USB Adapter Cable, with an AS3.0 system and the 
default mouse synchronization is not satisfactory, you can try the Redhat AS3.0 setting. In either 
case, you must perform the manual mouse synchronization procedures described in the next 
section.
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Manual Mouse Synchronization. If the local mouse pointer goes out of sync with the remote system's 
mouse pointer there are several methods to bring them back into sync.

1. Perform a video and mouse auto sync by clicking the Video Settings icon on the Control Panel 
(see page 30).

2. Perform an Auto Sync with the Video Adjustment function (see “Video Settings” on page 30, for 
details).

3. Invoke the Adjust Mouse function with the Adjust Mouse hotkeys (see “Adjust mouse” on 
page 28, for details).

4. Move the pointer into all 4 corners of the screen (in any order).
5. Drag the Control Panel to a different position on the screen.
6. Set the mouse speed and acceleration for each problematic server attached to the switch. See 

“Additional Mouse Synchronization Procedures” on page 108, for instructions.

Control Panel Configuration 

Click the Control Panel icon to open a dialog box. Configure the items and graphical settings on the 
Control Panel. 

Item Function
Customize 
Control Panel

Select which icons display in the Control Panel. Check the icons to be visible. Unchecked icons 
will not be displayed

Control Panel 
Style

Enabling Transparent makes the Control Panel semi-transparent so that the display underneath 
can be seen. When Enabled, the Control Panel displays as an icon until the mouse is moved over 
it, then the full panel opens.

Screen Options • If Full Screen Mode is enabled, the remote display fills the entire screen.
• If Full Screen Mode is not enabled, the remote display appears as a window on the local 

desktop. If the remote screen is larger than can fit in the window, move the mouse pointer to the 
screen border closest to the area you want to view and the screen will scroll.

• If Keep Screen Size is enabled, the remote screen is not resized.
• If the remote resolution is smaller than that of the local monitor, its display appears like a 

window centered on the screen.
• If the remote resolution is larger than that of the local monitor, its display is centered on the 

screen. To access the areas that are off screen, move the mouse to the corner of the screen that is 
closest to the area you want to view and the screen will scroll.

• If Keep Screen Size is not enabled, the remote screen is resized to fit the local monitor's 
resolution.

Scrolling 
Method

If the remote screen display is larger than your monitor, you can choose how to scroll to the areas 
that are off-screen.
• Select Mouse Movement to scroll the screen when the mouse pointer is moved to the screen 

border.
• Select Scroll Bars to open scroll bars around the screen borders that can be used to scroll to the 

off-screen areas.
Bus Info If Bus Info is enabled, the number of the bus you are on, as well as the total number of users on 

the bus, displays on the bottom row center of the Control Panel (Bus No./Total Users). 
Snapshot Configure the KVM switch's screen capture parameters.

• Path: The directory where captured screens will automatically get saved. Click Browse to 
navigate to the directory, then click OK. If a directory is not specified here, the snapshot is 
saved to your desktop.

• Click a radio button to save the captured screen as a BMP or a JPEG (JPG) file.
• With JPEG, the quality of the captured file can be adjusted with the slider bar. Higher quality 

will improve the appearance and increase the file size. 
Keyboard Pass 
Through

When enabled, the Alt-Tab key press is passed to the remote server and affects that server. If it is 
not enabled, Alt-Tab acts on your local client computer.
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The Java Control Panel

The Java Applet Viewer and Java Client AP Control Panel is similar to that used by the WinClient.
The major differences are:

•  In the Macros dialog box, Toggle Mouse Display is not available.
•  The Dot mouse pointer type is not available.
•  In the Message Board, there is no Show/ Hide button for the user list. This function is achieved by 

clicking the arrows at the top of the bar that separates the User List panel from the Main panel.
•  In Virtual Media, only ISO and Folder are supported. 
•  The Control Panel Lock LED icons are not in sync with your keyboard. When you first connect, 

the LED display may not be accurate. Click on the LED icons to set them.
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Port Access 

Overview
The Port Access page opens with the KVM switch's KVM Connections page displayed.

The Connections page is organized into several main areas. All the devices, ports, and outlets that a user 
is permitted to access are listed in the Sidebar at the left of the page. Any Rack PDU devices (Power 
Distribution Units) connected to the switches are listed separately below the switch listings. Blade 
Servers are listed below the PDU devices.
After selecting a device, port, or outlet in the Sidebar, clicking entries on the menu bar (Browser GUI) or 
tab bar (AP GUI) opens information and configuration pages related to the item.
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The Sidebar
All KVM switches, PDU devices, and Blade Servers including, their ports and outlets, are listed in a tree 
structure in the Sidebar at the left of the screen.

The Sidebar Tree Structure

•  Users only see the devices, ports, and outlets for which they have access permission.
•  Ports, outlets, and child devices can be nested under their parent devices.

Click the + in front of a device to expand the tree and see the ports/outlets nested underneath it. 
Click the - to collapse the tree and hide the nested ports/outlets.

•  ID numbers of the ports and outlets are displayed in brackets next to the icon. Ports and outlets 
can also be named.

•  Monitor screen icons are Green for on line switches and ports and Gray when offline.
•  Outlet Icons are Amber when On and Gray when Off.
•  To access and operate a port, double click its icon. 

Note: 1. In the Browser page, you can open as many port viewers as there are ports, but the 
number of ports that you see depends on the number of buses that the switch supports. 
2. In the AP GUI version only one port at a time can be accessed. To see two different ports, 
you have to log in two separate times.
3. PDU devices and Blade Servers do not appear in the Sidebar, (even if they are configured 
on the switch) if KVM Access Management is used.

Sidebar Utilities 

In the AP GUI Port Access Connections page, right click an item in the Sidebar to open the options list. 

Note: The items that appear in the options list depend on user permissions, or if you logged 
in remotely or from a Local Console.

Item User Type Description
Expand/
Collapse

Administrators 
Users

• If the device's ports are nested (not displayed), the dialog box entry is Expand. 
Click Expand to display the nested ports.

• If the device's ports are displayed, the dialog box entry is Collapse. Click Collapse 
to nest the ports.
Note: This item only appears for switches or ports that have child devices and has 
the same effect as clicking the + or - in the tree structure.

Rename Administrators 
Users

Administrators and users with port configuration permission can give each switch 
and port a name. 

Copy Administrators 
Users

This option is only available for ports. After selecting Copy, Paste the port into the 
Favorites page. See “Adding a Favorite” on page 49 for details.

Properties Administrators Administrators and users with port configuration permission can configure the 
properties for a switch or port.
• For switches, click to go to the Device Management page. 
• For ports, a dialog box opens where configuration settings for that port are made. 

Mount/
Unmount

Administrators 
Users

Only available through a Local Console login. It appears when a USB device is 
plugged into the switch's USB port and allows the device to be mounted and made 
available to logged in users.
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Port Properties. Select Properties from the popup menu to open a dialog box to enter configuration 
settings for the selected port.

Note: This is a quick setting method that performs similar port configuration functions to the 
ones performed in “Port Configuration” on page 55. 

Make the configuration choices and click Save to close the dialog box.

Port and Outlet Naming
Administrators and users with port configuration permission, can give each port or outlet a name. 
To assign, modify or delete a name:

1. Click once on the item you want to edit, wait a second, then click again. After a second or two, 
the field opens a text input box.

Note: 1. This is not a double click. It involves two separate clicks. A double click will 
switch you to the device attached to the port. 
2. In the AP GUI version you can right click on the port you want to edit, then select 
Rename in the popup box that appears, or you can highlight the port and press F2.

2. Enter a name for the item (or change or delete a previous name).
– Any combination of letters, numbers, and symbols on the typewriter keys of PC US English 

layout can be used. The maximum number of characters allowed is 20.
– Activate your local IME to input non-English characters. For languages that use 2 byte 

encoding, the maximum number of characters allowed is 9.
3. Press the [ENTER] key or click anywhere outside the input box to complete the operation.

Field Explanation
Port OS Specifies the operating system that the server on the connected port is using. Choices are Win, 

Mac, Sun, and Other. The default is Win.
OS Language Specifies the OS language being used by the server on the connected port. Select from the 

available choices in the drop down list. The default is English US.
Cable Length Specifies the length of the Cat5e cable that is used to connect the server to the port. Choices are 

Short (less than 10 m), Medium (10-25 m), and Long (greater than 25 m). The default is Short.
Note: Cable length can affect video quality. Shorter cables offer better quality. This setting is 
designed to compensate for longer or shorter cable lengths. Find the setting that best suits your 
connection.

Access Mode Define how the port is to be accessed when multiple users have logged on.
• Exclusive: The first user to switch to the port has exclusive control over the port. No other users 

can view the port. The Timeout function does not apply to ports with this setting.
• Occupy: The first user to switch to the port has control over the port. However, additional users 

may view the port's video display. If the user who controls the port is inactive for longer than the 
time set in the Timeout box, port control is transferred to the first user to move the mouse or 
strike the keyboard.

• Share: Users simultaneously share control of the port. Input from the users is placed in a queue 
and executed chronologically. Under these circumstances, users can take advantage of the 
Message Board, which allows users to communicate with each other regarding control of the 
keyboard and mouse or keyboard, mouse, and video.

Timeout Set a time threshold for users on ports whose Access Mode has been set to Occupy. If there is no 
activity from the user occupying the port for the amount of time set here, the user is timed out and 
the port is released. The first user to send keyboard or mouse input after the port has been released 
gets to occupy the port.
Enter a value from 0 to 255 seconds. The default is 3 seconds. A setting of 0 causes the port to be 
released the instant there is no input.
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Scan
Scan is located at the bottom of the AP GUI Sidebar and automatically switches among all the ports 
visible in the Sidebar at regular intervals, to monitor activity. See“Auto Scanning” on page 84 for details.

Note: Scan does not appear at the bottom of the Sidebar in the Browser version. Open it from 
the port's Toolbar. 

Array
Array is located at the bottom of the AP GUI Sidebar and is another way of monitoring port activity. 
Your screen is divided into a grid of panels, with each panel showing the video display of a particular 
port. Only ports visible in the Sidebar and on line are displayed. All other ports are blank. See“Panel 
Array Mode” on page 88 for details.

Note: Array does not appear at the bottom of the Sidebar in the Browser version. Open it 
from the port's Toolbar. 

Filter 
Control the number and type of ports that display in the Sidebar, as well as which ports get scanned when 
Auto Scan and Array Modes are invoked. Click Filter to show the choices on the bottom of the panel: 

KVM Devices and Ports - Connections Page
The Connections page displays port status information at the device level, and port connection 
configuration options at the port level for the KVM switches.

Device Level
When a KVM switch is selected in the Sidebar, the Connections page displays a list of ports for the 
device that the user is authorized to access or view. 

The following attributes are listed for each device:
•  Port Number - the port's number on the switch.
•  Port Name - if a name has been assigned to a port, it displays here.
•  Device Name - if a name has been assigned to the switch, it displays here.
•  Status - the current status of the port, online or offline.

Note: Change the sort order of the information displayed by clicking the column headings.

Double click anywhere on the line entry to access a port or select the port and click Connect at the 
bottom right of the page.

Choices Explanation
All This is the default view. With no other filter options selected, all of the ports that are accessible to 

the user are listed in the Sidebar.
When there are Favorites specified, select Favorites instead of All from the drop down list. In 
Favorites, only the items selected as Favorites display in the tree.

Powered On If Powered On is enabled (by putting a check in the checkbox), only ports that have their attached 
devices powered on display in the tree.

Search If you enter a search string and click Search, only port names that match the search string display in 
the tree. Wildcards (? for single characters; * for multiple characters) and keywords are supported, 
so that more than one port can appear in the list.

Exit Clicking Exit closes the filter dialog.
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Port Level

When a port is selected in the Sidebar, the Connections page displays the port connection and 
configuration options: The screen is divided into three panels.

Status. The current status information is displayed, including whether the port is online or offline, and if 
the port is mountable. Click the Connect button to view the port display from the switch's built-in Win 
Viewer, or Java Viewer.

Associated Links. Displays ports that have been associated with the currently selected port. 
Associations are configured on the Port Access > Port Configuration > Associated Links page.

Power Management. This page is used to connect a PDU power outlet with a port on the KVM switch. 
The power status of the device attached to the KVM port can be controlled from the Port Access page, 
rather than controlling the power status by opening a separate web session to the PDU device. The Power 
Management page is only available when a PDU device is connected to the switch.
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PDU Devices - Device Monitor Page
PDU devices connected to the switches are displayed below the KVM switches in the Sidebar. When a 
PDU device is selected in the Sidebar, the Device Monitor page opens. 

PDU View is the default page view, All PDU devices and outlets connected to the switch are listed under 
the Name column.

Outlets that are synchronized or that belong to groups have a green power outlet icon in front of their 
names. Click an outlet's green icon to display other outlets with which it synchronizes, or is grouped. 
Click the green outlet again to close the information display.

The Description column displays the KVM port associated with the outlet.

Action Buttons. The buttons are located at the bottom of the page. 

Button Action
Group View Click to switch the display to Group View.
Group Create a group of outlets.
Ungroup Remove items from a group.
On Sends a Power On signal to the selected outlet(s).
Off Sends a Power Off signal to the selected outlet(s).
Reboot Sends a Reboot signal to the selected outlet(s).
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Outlet Groups. Group and Ungroup buttons are located at the bottom of the page’s center section. 

1. To create an outlet group, select the outlets to include in the group.
2. Click Group to open the Outlet Group dialog box.
3. Select the group.

a. If the outlets will belong to a new group, give it a name in the text field.
b. If the outlets will belong to an existing group, select the group in the central panel.

4. Click Save. 
5. To remove outlets from groups select them in the main panel, then click Ungroup.
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The Main Panel - Group View

•  Click the PDU View button to go to the PDU View page.
•  To delete a group, select it in the main panel, then click Delete at the bottom of the page.
•  Select a group in the main panel, then click Ungroup, to remove all outlets from that group. This 

is a shortcut to remove all outlets at once, rather than one by one from the PDU View page.
•  To power manage a group of outlets, first select the group(s) in the main panel, then click the 

appropriate power button.
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Outlet Settings

When an outlet is selected in the Port Access page Sidebar, the Outlet Settings page opens.

The Outlet Properties panel indicates the name of the PDU that the outlet belongs to and the outlet's 
name, as well as On, Off, and Reboot buttons to manually manage the outlet's power.
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Adding a PDU in the KVM GUI main page 
1. Go to the Device Management tab, select the PDU Devices and click Add. 

2. Select the PDU Model.
3. Assign a name to the PDU.
4. User Name - Enter the PDU administrator user name.
5. Password - Enter your password.
6. Set the Scan Interval - This is the amount of time which the KVM switch checks outlet status 

from the PDU (from 1 to 99 minutes). Short intervals are not recommended in order to minimize 
impact on Telnet/HTTP users accessing the PDU.
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7. Enter the PDU Port - (1 or 2) The port on which the connection to the PDU is made.

8. Click Next to save or close to cancel.
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9. The PDU is added to the list.
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History
The History page provides a record of each time that a port was accessed. It provides quick access to the 
most recently used ports. You can access a port shown in the main panel by double clicking it.

•  If there are more entries than room on the screen, a scroll bar opens to allow the entire record to be 
viewed.

•  To clear the record and start over, click the Clear History button at the bottom right of the page.

Note: Click the column headings to change the sort order of the displayed information. 

Favorites
The Favorites page is similar to a bookmarks feature. Frequently accessed ports can be saved in a list. 
Favorites is a useful feature on large installations.

Adding a Favorite. 

1. With the port selected in the Port Access sidebar.
Right click in the main panel of the Favorites page to see the Add Favorite box.
Click on it or click Add at the bottom of the main panel to open an Untitled Favorite entry page.

2. Enter a name. Click on any empty space in the main panel to close the box.
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3. To add a port: 
– Drag it from the Sidebar and drop it onto the container,
– or right click on it in the Sidebar, select Copy, right click on the container, and select Paste, 
– or select the container in the main panel, select the port in the Sidebar then click Add to at the 

bottom of the main panel. 
4. The port’s switch is added to the container. The selected port is appended under the switch.

Note: 1. To add multiple ports at the same time, hold the Shift or Ctrl key down while 
making your Sidebar selections then drag or copy the group to the Favorites panel.
2. Favorites can be selected for filtering in the Sidebar. See “Filter” on page 40 for 
details. 

Modifying a Favorite. 

•  To modify a Favorite, or one of the items contained in it, right click on it, then select a choice from 
the popup menu.

•  To edit a Favorite's name:
– Click on it once, wait a second, then click again. Edit the name after the display opens a text 

input box (Port naming uses the same procedure), 
– or select the Favorite in the main panel, then click Modify at the bottom of the main panel.



User Preferences
Users may set up their own working environments. The switch stores a separate configuration record for 
each user profile according to the Username entered at Login. 

Setting Function
Language Select the language in which the interface displays.
OSD Hotkey Select which Hotkey controls the GUI function: [Scroll Lock] [Scroll Lock] is the default. To select 

a different combination, click the arrow at the right of the box to open a list of choices.
ID Display Select how the Port ID is displayed: the Port Number alone (PORT NUMBER), the Port Name 

alone (PORT NAME), or the Port Number plus the Port Name (PORT NUMBER + PORT NAME). 
The default is PORT NUMBER + PORT NAME.

ID Duration Determine how long a Port ID displays on the monitor after a port change has taken place. Choose 
from 1-255 seconds. The default is 3 Seconds. Setting to 0 (zero) means the Port ID is always on.

Scan Duration Determine how long the focus dwells on each port as it cycles through the selected ports in Auto 
Scan Mode (see “Auto Scanning” on page 84). Enter a value from 1-255 seconds. The default is 5 
second. Stting to 0 disables the Scan function.

Screen Blanker If there is no input from the console for the amount of time set here, the screen is blanked. Enter a 
value from 1-30 minutes. A setting of 0 disables this function. The default is 0.
Note: This function can be set from the local console or remote login, but it only affects the local 
console monitor.

Logout Timeout If there is no user input for the amount of time set with this function, the user is automatically 
logged out. Login is necessary before the KVM switch can be accessed again.

Toolbar Select whether or not the Port Toolbar is enabled when a port is accessed.
Since the Toolbar functions are also available from the GUI Control Panel (see “The Control 
Panel” on page 24), you may prefer to disable it here.

Viewer* Choose which viewer is used when accessing a server:
• Auto Detect will select the viewer based on the web browser used; WinClient for Windows 

Internet Explorer or Java Client for other web browsers (Firefox).
• Java Client opens the Java based viewer regardless of the web browser used.
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Sessions
The administrator and users with User Management permissions can see which users are currently 
logged into the KVM switch, and their session information.

Note: 1. Only users with User Management permissions can see sessions of ordinary users.
2. User type, SA (Super Administrator), Admin (Administrator), or Normal user (User), is 
listed under Category.

The IP heading refers to the IP address from which the user has logged in.

The Device and Port headings show which device and port the user is currently accessing. 

The Bus ID refers to the bus that the user is currently on (Bus 0 refers to the Local Console's bus).

Note: 1. Change the sort order of information displayed by clicking the column headings. 
2. The Bus ID also displays on the control panel. See “Users and Buses” on page 89 for more 
information.

The administrator can force a user logout from this page by selecting the user and clicking End Session 
at the bottom of the main panel.

Welcome Message* Hide or show the welcome message displayed in the submenu bar. The default is Disabled.
Save Click Save to save any changes made to the User Preferences settings.
Changing a 
Password

In the Browser GUI, enter the old password and new password into the input boxes. Enter the new 
password into the Confirm input box, then click Change Password to apply.
In the AP GUI version, click Change Password. Enter the old password and new password into the 
input boxes. Enter the new password into the Confirm input box, then click Save.

* This item is only available with the Browser version.
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Access
Set user and group access and configuration rights for switches and ports. Only those with User 
Management permissions can view the Access page. Normal users do not have access. 

Device Level Browser GUI Interface

The main panel consists of two columns: Name, and Config:

•  Name lists all the users and groups that have been created.
•  Config indicates the users who have Configuration privileges. A check mark indicates that the 

user has permission to make changes to the switch configuration settings. An X means that the 
user is denied permission to make configuration changes. Click the icon to toggle permission for 
Administrators and Users. Super Administrators always have configuration privileges.

•  The Copy and Paste buttons at the bottom of the main panel provide a shortcut method of 
assigning the permissions settings of one port to any of the other ports. 

– Select the port whose permissions you want to give to other port(s).
– Click Copy.
– Select the port that will receive the permissions.
– Click Paste.

•  Click the Save button to save the changes.
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Port Level Browser GUI Interface

Port access settings: 

Device Level AP GUI Interface

The page is the same as for the Browser GUI except that there are filters at the top of the columns to 
expand or limit the scope of the users and groups. 

Port Level AP GUI Interface

The page is the same as for the Browser GUI except that there are filters at the top of the columns to 
expand or limit the scope of the users and groups displayed. 

Setting Function
Name Each port accessible to the user is listed under the Names column.
Access Device access rights are set from the Access column. To see the choices, click the icon in the row 

that corresponds to the user you want to configure. 
Full Access The user can view the remote screen and can perform operations on the remote 

server from his keyboard and monitor.
View Only The user can only view the remote screen. He cannot perform any operations on it.
No Access No access rights - the Port will not appear on the User's list on the Main Screen.

Mount USB Configure permissions to mount Virtual Media devices on remote servers. To see the choices, click 
the icon in the row that corresponds to the user you want to configure. The icons are the same as in 
the Access column.
• Full Access: the user can mount, read, and write to the virtual media.
• View Only: the user can view the contents of the virtual media. No operations can be performed.
• No Access: the user will not see the virtual media even if it has been configured on the remote 

system.
Note: The entry does not appear for switches that do not support the USB Virtual Media function.

Config Set or deny permission for the user to change a port's configuration settings. A check mark indicates 
that the user has permission. An X means the user does not have permission.

PDU Permit or restrict the configuration and power operation of ports that have PDU devices connected. 
A check mark shows that the user has permission. An X means the user does not have permission.

Filter Description
Name To filter the User or Group name, enter the name, partial name, or partial name and wild 

card, then press Enter. Only the Users and Groups whose names correspond to the entry 
appear in the list. Wildcards (? for single characters, * for multiple characters) and the 
keyword “or” are supported. See page 59 for an example.

Config All All Users and Groups appear in the list.
Permitted Only Users and Groups with configuration permissions appear in the list.
Restricted Only Users and Groups that do not have configuration permissions appear in the list.

Setting Function
Name To filter the User or Group name, enter the name, partial name, or partial name and wild 

card ( * ) then press Enter. Only the Users and Groups whose names correspond to the 
entry appear in the list.

Access All All Users and Groups appear in the list.
Full Access Only Users and Groups with Full Access permissions appear in the list.
View Only Only Users and Groups with View Only permissions appear in the list.
No Access Only Users and Groups with No Access permissions appear in the list.
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Saving Changes. Click the Save button at the lower right corner of the page to save any changes made 
on the Access page.

Port Configuration
Device Level

When a device is selected in the Sidebar, the only item available under Port Configuration is the Port 
Properties page with one field to configure: the Occupy Timeout setting.

The Occupy Timeout field sets a time threshold for users on ports whose Access Mode has been set to 
Occupy. If there is no activity from the user occupying the port for the amount of time set here, the user 
is timed out and the port is released. The first user to send keyboard or mouse input after the port has 
been released gets to occupy the port.

Input a value from 0 to 255 seconds. The default is 3 seconds. Setting to 0 causes the port to be released 
the instant there is no input (not recommended).

Port Level
Port Properties

When a port is selected in the Sidebar, the Port Properties page displays information related to the ports.

•  Status panel: See if the port is online or offline, the Adapter cable type, and the Adapter's 
firmware level.

•  Properties panel: Make configuration settings for a selected port. 
•  Exit Macro panel: contains a list of user created System macros. Select a macro from the list that 

will execute when exiting the remote server. 
Click the Save button to save changes.

Associated Links
Associate other ports on the same switch to the selected port. This function is used when connecting both 
KVM and serial ports (using Server Module KVM-SERIAL) from a single server to the switch.

•  To associate a port with the currently selected port, click Add. Enter the port's number in the 
dialog box, then click OK. The port's number and name now appear in the main panel.

•  To remove an unwanted associated port, select it in the main panel, then click Remove.

Mount 
USB

All All Users and Groups appear in the list.
Full Access Only Users and Groups with Full Access Mount USB permissions appear in the list.
Read Only Only Users and Groups with Read Only Mount USB permissions appear in the list.
No Access Only Users and Groups with No Access Mount USB permissions appear in the list.

Config All All Users and Groups appear in the list.
Permitted Only Users and Groups with Permitted Config permissions appear in the list.
Restricted Only Users and Groups with Restricted Config permissions appear in the list.

PDU All All Users and Groups appear in the list.
Permitted Only Users and Groups with Permitted PDU permissions appear in the list.
Restricted Only Users and Groups with Restricted PDU permissions appear in the list.
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Power Management
The Power Management page is used to associate a Rack PDU power outlet with a KVM port on the 
KVM switch. Once an association is made, the power status of the device attached to the KVM port can 
be controlled from the Port Access page, rather than opening a separate web session to the PDU device.

Note: This page is only available when a PDU device is connected to the switch.

Adding and Removing Associations

The PDU Mapping dialog box opens with a list of all the outlets available for association. 

•  Check the outlet or outlets you want to associate with the port.
•  Click OK.
•  To disassociate an outlet from a port, select it in the main panel and click Remove.
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Configuration

Configure an outlet's settings directly from this page by clicking the Configuration button to open the 
PDU Outlet Configuration dialog box.  

Configuration options. 

Heading Explanation
Station The name of the device to which the outlet belongs.
Port The outlet's current name.
Name Enter a name for the outlet. The maximum number of characters is 15.
Power On Delay Set the amount of time the PDU waits after the Power Button is clicked before turning on 

the computer attached to the corresponding outlet.
The default delay time is 0 seconds. The maximum is 7200 seconds. 

Power Off Delay • Set the amount of time the PDU device waits after the Power button is clicked before 
shutting down the computer attached to the corresponding outlet.

• The default delay time is 0 seconds. The maximum delay time is 7200 seconds.
Power Reboot Delay • Set the amount of time the PDU waits after the computer is shutdown before turning on the 

computer attache to the corresponding outlet. 
• The default delay time is 5 seconds. The maximum delay time is 60 seconds.
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Synchronization

If more than one outlet has been selected for association with a port, Synchronization can be used to 
standardize their configurations. Enabling Synchronization (by checking the checkbox), opens the PDU 
Outlet Configuration dialog box. See “Configuration” on page 57. The settings are applied to all outlets 
associated with the port so that their settings are all the same.

To perform power management on PDU outlets associated with a KVM port, select the outlet then click 
On/Off/Reboot. 
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User Management

Overview
Click the User Management tab to open the User Management page. The page is organized into two 
main areas, the Sidebar at the left, and the large main panel at the right.

•  Users and groups appear in the panel at the left of the page. The large panel at the right provides 
more detailed information for each.

– The Browser GUI has separate menu bar entries for Accounts (Users) and Groups. Depending 
on the menu item selected, either Users or Groups are listed in the Sidebar.

– The AP GUI does not have menu entries. Users and Groups are listed separately in the 
Sidebar.

•  In the Browser GUI, change the sort order of the information displayed by clicking the main panel 
column headings.

•  In the AP GUI, the section below the Sidebar list provides a filter for managing the list.
– Click the arrow at the right of the list box to select to view only Users, only Groups, or both 

Users and Groups.
– Click to put a check in the Active checkbox to filter out any users whose accounts are not 

active.
– To select only Users or Groups that match a particular string, enter the string into the text box 

in front of the Go button, then click Go. Only Users or Groups that match the string will 
appear in the list.

Wildcards (? for single characters; * for multiple characters) and the keyword “or” are supported. 
Example: h*ds would return hands and hoods; 
h?nd would return hand and hind, but not hard; 
h*ds or h*ks would return hands and hooks.

•  The buttons below the main panel are used to manage users and groups.

Users
The KVM switch supports three types of user. 

User Type Role 
Super 
Administrator

Access and manage ports and devices. Manage Users, and Groups. Configure the overall 
installation. Configure personal working environment.

Administrator Access and manage authorized ports and devices. Manage Users and Groups. Configure 
personal working environment. 

User Access authorized ports and devices. Manage authorized ports and devices, configure personal 
working environment. 
Note: Users who have permission, may also manage other users.
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Adding Users
1. Select Users on the menu bar (Browser GUI) or Select Users in the Sidebar (AP GUI).
2. Click Add at the bottom of the main panel. The User notebook opens, with the User tab selected: 
3. Enter the required information in the fields.  

Field Description
Username From 1 to16 characters are allowed depending on the Account Policy settings. 

See “Account Policy” on page 76.
Password From 0 to16 characters are allowed depending on the Account Policy settings. 

See “Account Policy” on page 76.
Confirm Password Enter the password again to confirm it is correct. The two entries must match.
Description Additional information about the user that you may wish to include.
Role Three categories: Super Administrator, Administrator and User. No limit on the 

number of accounts created in each category.
• The Super Administrator is responsible for the overall installation configuration 

and maintenance; user management; and device and port assignments. The 
Super Administrator's permissions are system assigned and cannot be altered.

• The default permissions for Administrators include everything except Force to 
Grayscale, but the permissions can be altered for each Administrator by 
checking or unchecking any of the permissions checkboxes.

• The default permissions for Users include the Win, Java, and SSH clients. 
Permissions can be altered for each User by checking or unchecking any of the 
permissions checkboxes.
Note: Users who have User Management privileges cannot access or configure 
Groups.

Permissions 
Note: For ordinary 
users, in addition to 
enabling Device 
Management, Port 
Configuration, and 
Maintenance 
permissions, the user 
must also be given 
those rights for each 
device and port that he 
will be allowed to 
manage. See“Device 
Assignment” on 
page 64 for details.

• Enabling Device Management allows a user to configure and control the settings 
for overall KVM switch operations (see “Device Management” on page 67).

• Enabling Port Configuration allows a user to configure and control the settings 
for individual ports (see “Port Configuration” on page 55).

• Enabling User Management allows a user to create, modify, and delete user and 
group accounts.

• Enabling Maintenance allows a user to perform all the Maintenance operations 
available under the Maintenance tab (see “Maintenance” on page 92).

• Enabling System Log allows a user to access the system log (see “Log” on 
page 90).

• Enabling View Only limits users to only viewing the display of connected 
devices. 

• Enabling Windows Client allows a user to download the Windows Client AP 
software, and access the KVM switch with it, in addition to (or instead of) the 
browser access method.

• Enabling Java Client allows a user to download the Java Client AP software, and 
access the KVM switch with it, in addition to (or instead of) the browser access 
method.

• Enabling SSH Client allows a user to access the switch from an SSH session.
• Enabling Telnet Client allows a user to access the switch from a Telnet session.
• Force to Grayscale forces the user's remote display view to be in grayscale. This 

can speed up I/O transfer in low bandwidth situations.
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4. Assign a new user to a group by selecting the Groups tab. The user's port access rights can be 
assigned in the Devices page (page 64).

Note: This step can be skipped now to add more users and create groups. 

5. When the selections have been made click Save.
6. When the Operation Succeeded message appears, click OK.
7. Click Users in the Sidebar to return to the main screen. The new user appears in the Sidebar list 

and in the main panel.
The Sidebar Users list can expand and collapse. Click the minus symbol ( - ) next to the Users icon to 
collapse it. Click the plus symbol ( + ) to expand it.

The icon for super administrators has two black bands. The icon for administrators has one red band.

The large main panel shows the user's name, the description and if the account is currently active or has 
been disabled.

Modifying User Accounts

1. In the Sidebar User list, click the user's name, or in the main panel, select the user's name
2. Click Modify to open the dialog box.
3. Make your changes, then click Save.

Deleting User Accounts

1. In the main panel, select the user's name.
2. Click Delete.
3. Click OK.

Status Control the user's account and access to the installation:
• Disable Account: suspend a user's account without deleting it. 
• Select Account never expires if the account lifetime is unlimited. Select 

Account expires on and enter the expiration date to limit the account lifetime.
• Select User must change password at next logon. The administrator can set a 

temporary first time log in password, and the user can set his password for 
future logins.

• Select User cannot change password to make a password unchangeable. 
• Select Password never expires and users can keep their passwords indefinitely.

Select Password expires after and enter the number of days until the password 
expires to force a new password to be set.
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Groups
Device access rights apply to any member of the group. Administrators set them once for the group 
instead of each user individually. Multiple groups allow some users access to specific devices while 
restricting other users.

Creating Groups

1. Select Groups on the menu bar (Browser GUI) or Select Groups in the Sidebar (AP GUI).
2. Click Add at the bottom of the main panel to open the Group notebook with the Group tab 

selected.
3. Enter the required information in the fields. 

4. Users can be assigned to the group by selecting the Members tab. The Members page is discussed 
on page 64. You can also assign the group's port access rights by selecting the Devices tab 
(page 65).

Note: Skip this step and come back later to add more groups and assign users now. 

5. Click Save when finished.
6. When the Operation Succeeded message opens, click OK.
7. Click Group in the Sidebar to return to the main screen. The new group appears in the Sidebar 

Group list and in the main panel.
– The Sidebar Group list can expand and collapse.
– The large main panel shows the group's name and description (the Status column is inactive).

Note: Perform Step 7 before attempting to add another group, or the new group will replace 
the group you just created.

Modifying Groups

1. In the Sidebar Group list, click the group's name or in the main panel, select the group's name.
2. Click Modify.
3. Make changes in the Group notebook, then click Save.

Deleting Groups

1. In the Sidebar, click the Groups icon.
2. In the main panel, select the group's name.
3. Click Delete.
4. Click OK.

Field Description
Group Name A maximum of 16 characters is allowed.
Description Additional information about the user. A maximum of 63 characters is allowed.
Permissions Check the boxes to set permissions and restrictions for groups. These are the same 

permissions as the ones specified for Users. See page 60 for details.
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Users and Groups
Manage users and groups from the Users notebook and from the Group notebook.

Note: Before you can assign users to groups, you must first create them. See “Adding Users” 
on page 60 for details.

Assigning Users to a Group From the User's Notebook

1. In the Sidebar User list, click the user's name or in the main panel, select the user's name
2. Click Modify.
3. Select the Groups tab in the User notebook. 
4. In the Available column, select the group.
5. Click the Right Arrow to put the group's name into the Selected column.
6. Repeat the above for any other groups that the user will join.
7. Click Save to finish.

Note: If a user has permissions in addition to the ones assigned to the group, the user 
keeps those permissions in addition to the group ones.
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Removing Users From a Group in the User's Notebook

1. In the Sidebar User list, click the user's name or select the user's name in the main panel.
2. Click Modify.
3. Select the Groups tab when the User notebook opens. 
4. In the Selected column, select the group from which the user will be removed.
5. Click the Left Arrow to remove the group's name from the Selected column. (The group goes 

back into the Available column.)
6. Repeat the above for any other groups from which the user will be removed.
7. Click Save to finish.

Assigning Users to a Group From the Group's Notebook

1. In the Sidebar Group list, click the group's name or select the group's name in the main panel.
2. Click Modify.
3. In the Group notebook that comes up, select the Members tab. 
4. In the Available column, select the user that will be added to the group.
5. Click the Right Arrow to put the user's name in the Selected column.
6. Repeat for any other users that will be added to the group.
7. Click Save when you are done.

Note: If a user has additional permissions to those assigned to the group, the user 
keeps those permissions in addition to the group permissions.

Removing Users From a Group From the Group's Notebook

1. In the Sidebar Group list, click the group's name or select the group's name in the main panel.
2. Click Modify.
3. In the Group notebook that opens, select the Members tab to open the screen.
4. In the Selected column, select the user that to be removed from the group.
5. Click the Left Arrow to remove the user's name from the Selected column. (It goes back into the 

Available column.)
6. Repeat for any other users to be removed from the group.
7. Click Save when finished.

Device Assignment
When a user logs in to the KVM switch, the Port Access page opens. All ports that the user is permitted 
to access are listed in the Sidebar at the left of the page. Access permissions for those ports and the 
devices connected to them are assigned on a port-by-port basis from the User or Group list on the 
Sidebar of the User Management page.
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Assigning Device Permissions From the User's Notebook

1. In the Sidebar User list, click the user's name or select the user's name in the main panel.
2. Click Modify to open the User notebook. 
3. Select the Devices tab to open the page. 

4. Make your permission settings for each port from the columns on the page.
– Name: Each port accessible to the user is listed under the Names column.
– Access: Set device access. Click the icon in the row of the port to be configured to view the 

choices. 

Icon Name Description
Full Access The user can view the remote screen and can perform operations on 

the remote server from his keyboard and monitor.

View Only The user can only view the remote screen; he cannot perform any 
operations on it.

No Access No access rights - the Port will not show up on the User's list on the 
Main Screen.
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– USB: Lists USB Virtual Media devices. (Does not appear for switches that do not support the 
USB Virtual Media function.) Click the icon in the row for the port you want to configure to 
view the choices.

• Full Access means that the User can mount, read, and write the virtual media. 
• View Only means that the user can only read already mounted virtual media data.

– Config: Permit or restrict a user's permission to make changes to a port's configuration 
settings. Click the icon in the row for the port you want to configure to view the choices. 

• A check mark indicates that the user has permission to make changes to the port's 
configuration settings.

• An X means that the user is denied permission to make configuration changes.
– PDU: Permit or restrict the configuration and power operation of ports that have PDU devices 

connected to them. 
• A check mark indicates that the user has permission. 
• An X means that the user does not have permission. 

5. Click Save when finished. Click OK to confirm.
Note: Use Shift-Click or Ctrl-Click from any column to select a group of ports to configure. 
Clicking to see the choices on any one of the selected ports causes all of them to cycle in 
unison.

Filters. Expand or limit the scope of the ports that are displayed in the Name column using the five 
filters at the top of the columns. 

Assigning Device Permissions From the Groups' Notebook
1. In the Sidebar Groups list, click the group's name or select the group's name in the main panel.
2. Click Modify to open the Groups notebook. 
3. Select the Devices tab to open a screen that looks the same as the one in the User's notebook. The 

settings here apply to all group members instead of just one user. Make device assignments 
according to the information described under “Assigning Device Permissions From the User's 
Notebook” on page 65.

Filter Description
Name To filter the port name, enter the name then press [ENTER]. Only ports whose names 

correspond to the entry appear in the list.
Wildcards (? for single characters; * for multiple characters) and the keyword “or” are 
supported. See page 59 for an example.

Access All All ports appear in the list.
Full Access Only ports configured as Full Access ports appear in the list.
View Only Only ports configured as View Only ports appear in the list.
No Access Only ports configured as No Access ports appear in the list.

USB All All ports appear in the list.
Full Access Only ports configured as Full Access USB ports appear in the list.
Read Only Only ports configured as Read Only USB ports appear in the list.
No Access Only ports configured as No Access USB ports appear in the list.

Config All All ports appear in the list.
Permitted Only ports configured as Permitted appear in the list.
Restricted Only ports configured as Restricted appear in the list.

PDU All All ports appear in the list.
Permitted Only ports configured as Permitted appear in the list.
Restricted Only ports configured as Restricted appear in the list.
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Device Management

Device Information
The Device Management page opens with the top level (parent) KVM switch selected in the Sidebar and 
Device Information selected on the menu bar.

General

The General section of the Device Information page displays the name of the selected device, its 
firmware version, and information about its network configuration.

Note: The AP GUI version presents the same information as the Browser version. Scroll 
through the list to see additional entries.

Environment

The lower panel displays the device's environment information. 

Operating Mode

Use the Operating Mode page to set working parameters.

•  Force all to grayscale: Enable to change the remote displays of all devices connected to the KVM 
switch to grayscale. This can speed up I/O transfer in low bandwidth situations.

•  Enable Device List: Enable for the switch to appear in the Server List of WinClient or Java Client 
AP. See “Windows Client AP Login” on page 20, and “Java Client AP Login” on page 21. The 
switch can still be connected, but its name will not appear in the Server List if the option is not 
enabled.

Item Description
Power Supply 
Detection 

Power Supply 1 and Power Supply 2 icons display in gray when there is no power to the power 
supply and in blue when power is present.
When enabled (there is a check in the checkbox), if there is only one source of power, a constant 
warning beeps. A message displays asking for confirmation that having one power source is 
intentional.
If one source of power is intended, to stop the beeping:
• Uncheck the checkbox to disable the function permanently. 
• Confirm your intention in the dialog box to disable the warning temporarily. The warning 

function will be back on after the next system reset.
The default for this function is enabled.

Fan Warning 
Message

Place a check in the checkbox to enable a fan warning message. If enabled, when any fan stops 
spinning the system records the event in the system log. If it is not enabled, the event will not be 
recorded. The default for this function is enabled.
Note: The warning does not mean that the fan has failed, since the fans stop when the 
temperature drops below the device's lower temperature setting.

Fan Speed Displays fan speeds. See “Fan Location and Speed Information” on page 109.
Temperature 
Warning 
Message

Place a check in the checkbox to enable a temperature warning message. If enabled, when the 
device's temperature drops below the Low threshold setting, or exceeds the High threshold 
setting, the system records the event in the system log. If it is not enabled, the event will not be 
recorded. The default is enabled.

Temperature Displays temperature readings from the switch's built-in sensors in Celsius or Fahrenheit. See 
“Temperature Sensor Location and Information” on page 109.
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•  Enable First Rider Transfer: Only the first user on a bus can switch ports when enabled. Other 
users on the bus cannot switch ports unless another bus is already connected to the port they 
would like to access, or there is a free bus available. See “Users and Buses” on page 89 for more 
information. 

•  Keyboard/Mouse Broadcast: Choose the setting from the drop down list.
– Keyboard Broadcast: Keystrokes will be duplicated on all attached servers currently listed in 

the Sidebar when enabled.
– Mouse Broadcast: Mouse movements and clicks will be duplicated on all attached servers 

currently listed in the Sidebar when enabled.
Note: 1. On a child KVM switch tiered from the parent or top level KVM switch, 
only one port can perform a Keyboard/Mouse broadcast at a time. 
2. For Mouse Broadcast, you and all the servers must be running the same OS, the 
monitors must have the same resolution, and screens must have an identical layout.

•  Console Keyboard Language: Specify which keyboard mapping is being used by the Local 
Console keyboard from the drop down list.

Network 

IP Installer. The IP Installer is an external Windows-based utility for assigning IP addresses to the KVM 
switch. Click one of the radio buttons to select Enable, View Only, or Disable for the IP Installer utility. 
See “IP Installer” on page 105 for details.

Note: If you select View Only, you can see the KVM switch in the IP Installer’s Device List, 
but you cannot change the IP address. For security, it is recommended to set this to View 
Only or Disable after each use.

Service Ports. As a security measure, if a firewall is being used, the Administrator can specify the port 
numbers that the firewall will allow. If a port other than the default is used, users must specify the port 
number as part of the IP address when they log in. If an invalid port number (or no port number) is 
specified, the KVM switch will not be found. 

Note: 1. Valid entries for all Service Ports are from 1-65535. 
2. Service ports cannot have the same value. Set a different value for each port. 
3. If there is no firewall (on an Intranet, for example), these numbers will have no effect.

Field Explanation
Program This is the port number for connecting with the WinClient ActiveX Viewer, WinClient AP, Java 

Applet Viewer, Java Client AP, or via Virtual Media. The default is 9000.
HTTP The port number for a browser login. The default is 80.
HTTPS The port number for a secure browser login. The default is 443.
SSH The port for SSH access. The default is 22.
Telnet The port for Telnet access. The default is 23.
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NIC Settings. 

Redundant NIC 
The KVM switch is designed with two network interfaces. If Redundant NIC is enabled (the default), 
both interfaces make use of the IP address of Network Adapter 1. The second interface is usually 
inactive. If there is a network failure on the first interface, the switch automatically switches to the 
second interface.

Redundant NIC Enabled - Single IP Address for Both Interfaces

1. Click to put a check in the Redundant NIC checkbox.
2. Network Adapter 1 is selected in the network adapter listbox, disabling the listbox. You cannot 

configure Network Adapter 2.
3. Configure the IP and DNS server addresses for Network Adapter 1 (see the sections below).

Redundant NIC Not Enabled - Two IP Addresses
If you choose not to enable the Redundant NIC function, the two NICs can be configured with separate 
interfaces. Users can log into the KVM switch with either IP address. 
To set up the switch with this configuration:

1. If there is a check in the Redundant NIC checkbox, click to remove it.
2. In the network adapter listbox, select Network Adapter 1.
3. Configure the IP and DNS server addresses for Network Adapter 1.
4. Select Network Adapter 2 from the network adapter list.
5. Configure the IP and DNS server addresses for Network Adapter 2.

IPv4 Settings

IP Address:
IPv4 is the traditional method of specifying IP addresses. The KVM switch can either have its IP address 
assigned dynamically (DHCP), or it can be given a fixed IP address.

•  For dynamic IP address assignment, select the Obtain IP address automatically radio button. 
(This is the default setting.)

•  To specify a fixed IP address, select the Set IP address manually radio button and fill in the 
fields with values appropriate for your network.

Note: 1. If you choose Obtain IP address automatically, when the switch starts up it waits to 
get its IP address from the DHCP server. If it hasn't obtained the address after one minute, it 
automatically reverts to its factory default IP address (192.168.0.60.) 
2. If the switch is on a network that uses DHCP to assign network addresses, and you need to 
ascertain its IP address, see “IP Address Determination” on page 105, for information.

DNS Server

•  For automatic DNS Server address assignment, select the Obtain DNS Server address 
automatically radio button.

•  To specify the DNS Server address manually, select the Set DNS server address manually radio 
button, and fill in the addresses for the Preferred and Alternate DNS servers with values 
appropriate for your network.

Note: Specifying the Alternate DNS Server address is optional.
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IPv6 Settings
IP Address: 
IPv6 is the new (128-bit) format for specifying IP addresses. (See “IPv6” on page 106 for further 
information.) The KVM switch can either have its IPv6 address assigned dynamically (DHCP), or it can 
be given a fixed IP address.

•  For dynamic IP address assignment, select the Obtain IP address automatically radio button. 
(The default setting.)

•  To specify a fixed IP address, select the Set IP address manually radio button and fill in the 
fields with values appropriate for your network.

DNS Server
•  For automatic DNS Server address assignment, select the Obtain DNS Server address 

automatically radio button.
•  To specify the DNS Server address manually, select the Set DNS server address manually radio 

button, and fill in the addresses for the Preferred and Alternate DNS servers with values 
appropriate for your network.

Note: Specifying the Alternate DNS Server address is optional.

Network Transfer Rate
This setting allows you to tailor the size of the data transfer stream to match network traffic conditions 
by setting the rate at which the KVM switch transfers data between itself and the client computers. The 
range is from 4-99999 Kilobytes per second (KBps).
Finishing 
Be sure to enable Reset on exit on the Device Management > System Operation page (see “Reset on 
exit” on page 94), before logging out to allow network changes to take effect without powering the 
switch off and on.

ANMS
Use ANMS (Advanced Network Management Settings) to set up login authentication and authorization 
management from external sources. It is organized as a notebook with two tabs, each with a series of 
related panels.

Event Destination. 
SMTP Settings 
To have the KVM switch email reports from the SMTP server to you:

1. Enable the Enable report from the following SMTP server, and enter the IPv4 address, IPv6 
address, or domain name of the SMTP server.

2. If your server requires a secure SSL connection, put a check in the My server requires secure 
connection (SSL) checkbox.

3. If your server requires authentication, put a check in the My server requires authentication 
checkbox, and enter the account information in the Account Name and Password fields.

4. Enter the email address where the report will be sent in the From field. Put only one email 
address in the From field. It cannot exceed 64 Bytes. 

5. Enter the email address (addresses) where you want the SMTP reports sent in the To field.
Note: If the report will be sent to more than one email address, separate the addresses 
with a semicolon. The total cannot exceed 256 Bytes.
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Log Server. 
Important transactions that occur on the KVM switch, such as logins and internal status messages, are 
kept in an automatically generated log file. See “Log” on page 90, for details on setting up the log server. 

•  Specify the MAC address of the computer that the Log Server runs on in the MAC address field.
•  Specify the port used by the computer that the Log Server runs on to listen for log details in the 

Port field. The valid port range is 1-65535. The default port number is 9001.

Note: The port number must different than the one used for the Program port.

SNMP Server. Enable to be notified of SNMP trap events:

1. Check Enable SNMP Agent.
2. Enter the IPv4 address, IPv6 address, or domain name of the computer to be notified.
3. Enter the port number. The valid port range is 1-65535.

Note: The logs that are notified of SNMP trap events are configured on the Notification 
Settings page under the Log tab. See “Log Notification Settings” on page 91 for details.

Syslog Server. 
To record all the events that take place on KVM switches and write them to a Syslog server:

1. Check Enable.
2. Enter the IPv4 address, IPv6 address, or domain name of the Syslog server.
3. Enter the port number. The valid port range is 1-65535.

Authentication

Disable Local Authentication. 
Selecting this option disables login authentication on the KVM switch. The switch can only be accessed 
using LDAP, LDAPS, MS Active Directory, RADIUS or KVM Access Management Server 
authentication.
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RADIUS Settings. 
To allow authentication and authorization for the KVM switch through a RADIUS server:

1. Check Enable.
2. Enter the IP addresses and service port numbers for the Preferred and Alternate RADIUS servers. 

Use the IPv4 address, the IPv6 address or the domain name in the IP fields.
3. In the Timeout field, set the time in seconds that the KVM switch waits for a RADIUS server 

reply before it times out.
4. In the Retries field, set the number of allowed RADIUS retries.
5. In the Shared Secret field, key in the character string that you want to use for authentication 

between the KVM switch and the RADIUS Server. A minimum of 6 characters is required.
6. On the RADIUS server, Users can be authenticated with any of the following methods:

– Set the entry for the user as su/xxxx. (xxxx represents the Username given to the user when the 
account was created on the KVM switch.)

– Use the same Username on both the RADIUS server and the KVM switch.
– Use the same Group name on both the RADIUS server and the KVM switch.
– Use the same Username/Group name on both the RADIUS server and the KVM switch.

Assign the same user access rights that were assigned when the User of Group was created on the KVM 
switch. See “Adding Users” on page 60.

LDAP / LDAPS Authentication and Authorization Settings. 
To allow authentication and authorization for the KVM switch via LDAP / LDAPS: 

Item Action
Enable Put a check in the Enable checkbox to allow LDAP / LDAPS authentication and 

authorization.
Type Click a radio button to specify whether to use LDAP or LDAPS.
LDAP Server IP 
and Port

Fill in the IP address and port number for the LDAP or LDAPS server.
• Use the IPv4 address, the IPv6 address or domain name in the LDAP Server field.
• For LDAP, the default port number is 389; for LDAPS, the default port number is 636.

Admin DN Consult the LDAP / LDAPS administrator to ascertain the appropriate entry for this field. For 
example, the entry might look like this:

ou=kn4132,dc=aten,dc=com
Admin Name Key in the LDAP administrator's username.
Password Key in the LDAP administrator's password.
Search DN Set the distinguished name of the search base. This is the domain name where the search 

starts for user names.
Timeout Set the time in seconds that the KVM switch waits for an LDAP or LDAPS server reply 

before it times out.
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On the LDAP / LDAPS server, Users can be authenticated with any of the following methods:

•  With MS Active Directory schema.
Note: If this method is used, the LDAP schema for MS Active Directory must be 
extended. See “LDAP Server Configuration” on page 97, for details.

•  Without schema - Only the Usernames used on the KVM switch are matched to the names on the 
LDAP / LDAPS server. User privileges are the same as the ones configured on the switch.

•  Without schema - Only Groups in AD are matched. User privileges are the ones configured for the 
groups he belongs to on the switch.

•  Without schema - Usernames and Groups in AD are matched. User privileges are the ones 
configured for the User and the Groups he belongs to on the switch.KVM Access Server Settings

To allow authorization for the KVM switch through a KVM Access server, check Enable and enter the 
Server's IP address and Service port in the appropriate fields. You can use the IPv4 address, the IPv6 
address or the domain name in the Server IP field.

Note: If this function is enabled, PDU devices and Blade Servers do not appear in the 
Sidebar, even if they are configured on the switch because they are managed on the server.

OOBC
In case the KVM switch cannot be accessed with the usual LAN-based methods, it can be accessed from 
the switch's modem port. A modem (customer supplied) is connected to the switch using an APC adapter 
cable (provided). To enable support for PPP (modem) operation, click to put a checkmark in the Enable 
Out of Band Access checkbox. See “PPP Modem Operation” on page 107, for PPP setup and operation. 

When Out of Band Access is enabled, the Enable Dial Back, and Enable Dial Out functions become 
available.

Enable Dial Back. For security, if this function is enabled, the switch disconnects calls that dial in, and 
dials back to the selected option. 

Item Action
Enable Fixed Number 
Dial Back

If enabled, the KVM switch hangs up from an incoming call and dials back to the modem 
whose phone number is specified in the Phone Number field. Enter the phone number of 
the modem that you want the KVM switch to dial back to in the Phone Number field.

Enable Flexible Dial 
Back

If enabled, the modem that the KVM switch dials back does not have to be fixed. It can 
dial back to any modem that is convenient for the user:

1. Enter a password that the users must specify in the Password field.
2. When connecting to the KVM switch's modem, users specify the phone number of the 
modem that they want the KVM switch to dial back to as their Username, and specify 
the password set in the Password field for their password.
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Enable Dial Out. For the dial out function, establish an account with an Internet Service Provider, and 
use a modem to dial up to your ISP account. 

Click Save when finished.

Item Action
ISP Settings Specify the telephone number, account name (username), and password that you use to 

connect to your ISP.
Dial Out Schedule Set the times for the KVM switch to dial out over the ISP connection.

• Every: Provides a listing of fixed times from every hour to every four hours.
Example: Select Every two hours and the KVM switch will start dialing out every two 
hours beginning at 00:00.
Select Never from the list if you don't want the KVM switch to dial out on a fixed 
schedule.

• Daily at will dial out once a day at a specified time. Use the hh:mm time format.
• PPP online time specifies how long the ISP connection lasts before terminating the 

session and hanging up the modem. A setting of zero means it is always on line.
Emergency Dial Out If the KVM switch gets disconnected from the network, or the network goes down, this 

function puts the switch on line via the ISP dial up connection.
• Choose PPP stays online until network recovery and the PPP connection to the ISP 

will last until the network comes back up or the switch is able to reconnect.
• Choose PPP online time and the connection to the ISP will terminate after the time 

specified. A setting of zero means it is always on line.
Dial Out Mail 
Configuration

Receive email notification of problems on the devices connected to the KVM switch's 
ports (see “SMTP Settings To have the KVM switch email reports from the SMTP server 
to you:” on page 70).
Note: This email notification differs from the one configured under SMTP Settings. It 
uses the ISP mail server rather than the internal company's mail server.
• Enter the IPv4 address, IPv6 address, or domain name of your SMTP server in the SMTP 

Server IP Address field.
• Enter the email address of the person responsible for the SMTP server (or another 

responsible administrator), in the Email From field.
• Enter the email address (addresses) where the report will be sent in the To field. To send 

to more than one email address, separate the addresses with a comma or a semicolon.
• If your server requires a secure SSL connection, put a check in the SMTP server 

requires secure connection (SSL) checkbox.
• If your server requires authentication, put a check in the SMTP server requires 

authentication checkbox, enter the account name and password in the fields.
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Security
Login Failures

For increased security, administrators can set policies governing user log in failures. Check the Enable 
checkbox (the default is enabled). 

Note: If Login Failures is not enabled, users can attempt to log in an unlimited number of 
times with no restrictions. For security purposes, enable the function and lockout policies.

Filter

IP and MAC Filtering
Control access to the KVM switch based on the IP and/or MAC addresses of the client computers 
attempting to connect. A maximum of 100 IP filters and 100 MAC filters are allowed. If any filters have 
been configured, they appear in the IP Filter and/or MAC Filter list boxes.

To enable, click to put a check mark in the IP Filter Enable and/or MAC Filter Enable checkbox.

•  If the Include button is checked, all the addresses within the filter range are allowed access; all 
other addresses are denied access.

•  If the Exclude button is checked, all the addresses within the filter range are denied access; all 
other addresses are allowed access.

Adding Filters 
To add an IP filter:

1. Click Add to open the dialog box.
2. Specify an IPv4 or IPv6 address.
3. Enter the address you want to filter in the From: field.

– To filter a single IP address, click to put a check in the Single IP checkbox.
– To filter a continuous range of addresses, enter the end number of the range in the To: field.

Note: This description is for the AP GUI. The Browser GUI does not offer an IPv4 or 
IPv6 choice. It only has From and To fields for IPv4 filtering and does not have a 
checkbox to specify a single IP address. To filter a single IPv4 address, enter the same 
address in both From and To fields.

4. After filling in the address, click OK.
5. Repeat the steps to filter additional IP addresses.

Entry Explanation
Allowed Sets the number of consecutive failed login attempts permitted from a remote computer. The 

default is 5 times.
Timeout Sets the amount of time a remote computer must wait before attempting to login again after 

exceeding the allowed failures. The default is 3 minutes.
Lock Client PC If enabled, after the allowed failures have been exceeded, the computer attempting to log in is 

locked out. No logins from that computer will be accepted. The default is enabled.
Note: If the client computer's IP is changed, the computer will no longer be locked out.

Lock Account If enabled, after the allowed failures are exceeded, the user attempting to log in is 
automatically locked out. No logins from the failed username and password will be accepted. 
The default is enabled.
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To add a MAC filter:

1. Click Add to open the dialog box.
2. Specify the MAC address, then click OK.
3. Repeat the steps to filter additional MAC addresses.

IP Filter / MAC Filter Conflict. If there is a conflict between an IP filter and a MAC filter (a computer's 
address is allowed by one filter but blocked by the other) then the blocking filter takes precedence (the 
computer's access is blocked).

Modifying Filters. To modify a filter, select it in the IP Filter or MAC Filter list boxes and click 
Modify. The Modify dialog box is similar to the Add dialog box. When it opens, delete the old 
address(es) and replace with the new address(es).

Deleting Filters. To delete a filter, select it in the IP Filter or MAC Filter list box and click Delete.

Login String. The Login String entry field lets the super administrator specify a login string (in addition 
to the IP address) that users must add to the IP address when they access the KVM switch with a 
browser. Example: if 192.168.0.126 were the IP address, and abcdefg were the login string, the user 
would have to enter: 192.168.0.126/abcdefg

Note: 1. Users must place a forward slash between the IP address and the string.
2. If no login string is specified, anyone can access the KVM switch login page using the IP 
address alone, making the installation less secure.

•  The following characters are allowed in the string: 0-9 a-z A-Z ~ ! @ $ & * ( ) _ - = + [ ] , . |
•  The following characters are not allowed: % ^ " : / ? # \ ' { } ; ' < > [Space]
•  Compound characters (É Ç ñ ... etc.)

For security purposes, it is recommended that the string be changed occasionally.

Account Policy

System administrators can set policies governing usernames and passwords. 

Entry Explanation
Minimum Username 
Length

Sets the minimum number of characters required for a username. Acceptable values are 
from 1-16. The default is 3.

Minimum Password 
Length

Sets the minimum number of characters required for a password. Acceptable values are 
from 0-16. A setting of 0 means that no password is required. Users can login with only a 
Username. The default is 3.

Password Must 
Contain At Least

Checking any item in this section requires users to include at least one uppercase letter, 
one lowercase letter or one number in their password.
Note: This policy only affects user accounts created after this policy has been enabled, 
and password changes to existing user accounts. Users accounts created before the policy 
is enabled, and existing passwords that have not been changd, are not affected.

Disable Duplicate 
Login

Check to prevent users from logging in with the same account at the same time.
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Encryption

Fexible encryption alternatives for keyboard/mouse, video, and virtual media data let you choose any 
combination of DES; 3DES; AES; RC4; or a Random cycle of any or all of them. Enabling encryption 
affects system performance. No encryption offers the best performance. The greater the encryption the 
greater the adverse effect. If you enable encryption, performance considerations are:

•  RC4 offers the least impact on performance; DES is next; then 3DES or AES.
•  The RC4 + DES combination offers the least impact of any combination.

Mode

Item Explanation
Enable ICMP If ICMP is enabled, the KVM switch can be pinged. If it is not enabled, the device cannot be 

pinged. The default is Enabled.
Enable Multiuser 
Operation

Enabling Multiuser Operation permits up to 32 users to log in at the same time to share the 
remote bus. If not enabled, only one user can log in at a time. The default is Enabled.

Enable Virtual Media 
Write Operation

Enabling Virtual Media Write Operation allows redirected virtual media devices on a user's 
system to send data to a remote server, as well as being able to have data from the remote 
server written to them.

Enable Local Virtual 
Media

Enabling Local Virtual Media allows USB storage peripherals (CD/DVD, HD, flash drives, 
etc.) connected to the KVM switch to appear and act as if installed on a remote system.

Browser Service Enabling allows the administrator to restrict browser access to the KVM switch. After 
checking Browser Service, select the degree of restriction from the list.
• Disable Browser: no browser access is permitted.
• Disable HTTP: browser access is permitted, but the switch must be accessed with an 

HTTPS URL.
• Disable HTTPS: browser access is permitted, but users must access the switch with an 

HTTP URL.
Disable 
Authentication

If checked, no authentication procedures check users attempting to log in. Users gain 
Administrator access to the KVM switch by entering their username and password.
Note: Enabling this setting creates an extremely dangerous security condition, and should 
only be used under very special circumstances.
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Private Certificate

When logging in over a secure (SSL) connection, a signed certificate is used to verify that the user is 
logging in to the intended site. For enhanced security, the Private Certificate section allows you to use 
your own private encryption key and signed certificate, rather than the default certificate. 

There are two methods for establishing your private certificate:

•  Generating a Self-Signed Certificate 
To create your own self-signed certificate, free utilities are available for download over the web. 
See “Self-Signed Private Certificates” on page 112 for more information.

•  Obtaining a CA Signed SSL Server Certificate 
For the greatest security, a third party certificate authority (CA) signed certificate is 
recommended. To obtain a third party signed certificate, go to a CA (Certificate Authority) 
website to apply for an SSL certificate. After the CA sends you the certificate and private 
encryption key, save them to a convenient location on your computer. 

•  Importing the Private Certificate 
To import the private certificate: 
1. Click Browse to the right of Private Key, browse to the location of your private encryption key 
file and select it. 
2. Click Browse to the right of Certificate, browse to the location of your certificate file and select 
it.
3. Click Upload to complete the procedure.

Note: 1. Click Restore Default to returns the device to using the default certificate. 
2. Both the private encryption key and the signed certificate must be imported at the 
same time.
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Certificate Signing Request

The Certificate Signing Request (CSR) is located under Device Management >Security >Private 
Certification section. The Certificate Signing Request (CSR) section provides an automated way to 
obtain and install a CA signed SSL server certificate. The KVM switch supports 1024-bit certificates 
only in .cer format of x509 type.

To perform this operation:

1. Click Create CSR to open the dialog box.
2. Fill in the form with valid entries for your site. There are no unacceptable characters. 

3. Click Create when finished (all fields are required). A self-signed certificate based on the 
information just provided is now stored on the KVM switch.

4. Click Get CSR, and save the certificate file (csr.cer) to your computer. This is the file given to 
the third party CA to apply for their signed SSL certificate.

5. After the CA sends you the certificate, save it to a convenient location on your computer. Click 
Browse to locate the file; then click Upload to store it on the KVM switch.

Note: When the file is uploaded, the KVM switch checks the file to make sure the 
specified information still matches. If it does, the file is accepted, if not, it is rejected.

To remove the certificate (Example: replacing it due to a domain name change), click Remove CSR.

Date/Time

The Date/Time dialog page sets the KVM switch time parameters according to the information below.

Time Zone. 

•  Choose from the Time Zone list the city that corresponds to the location of the KVM switch.
•  If your country or region employs Daylight Saving Time (Summer Time), check the 

corresponding checkbox.

Information Max Characters Example
Country 2 letter code US
State or Province 32 Missouri
Locality 32 St. Louis
Organization 64 Your Company, Ltd.
Unit 32 Techdoc Department
Common Name 32 mycompany.com

Note: The domain name of the site must be exact for the certificate 
is to be valid. If the domain name is www.mycompany.com, and 
only mycompany.com is specified, the certificate will not be valid.

Email Address 64 administrator@yourcompany.com
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Date. 

•  Select the month from the list.
•  Click < or > to move backward or forward by one year increments.
•  In the calendar, click on the day.
•  To set the time, use the 24 hour HH:MM:SS format.
•  Click Set to save your settings.

Network Time. 

To automatically sychronize the time to a network time server:

1. Check the Synchronize with NTP Server checkbox.
2. Select your preferred time server from the list or check the Preferred custom server IP checkbox, 

and enter the IPv4 address, IPv6 address, or domain name of the time server.
3. If you want to configure an alternate time server, check the Alternate time server checkbox, and 

repeat step 2 for the alternate time server entries.
4. Enter the number of days between synchronization procedures.
5. If you want to synchronize immediately, click Update Using NTP Now.
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PDU Devices
Configuration Page

Select a PDU device in the Sidebar to open its Configuration page. 
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Outlet Configuration

•  Click on a PDU to open a list of choices.
•  Click to put a check mark in front of the outlets to be configured. Change the setting for any of the 

selected outletsand each of the selected outlets gets the new setting.
•  To select all of the outlets, check the box in front of the PDU’s name. Change the setting for any of 

the outlets and all of the outlets get the new setting. 

Configure Outlet Time Delay

1. In the Device Management page, select the PDU. 
2. Change delay settings (seconds) by clicking on the numbers. Put check marks in the boxes in 

front of the outlets in the list to apply the same setting to all selected.
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Port Operation
After logging in, the KVM switch opens to the Port Access tab's Connections page, with the first KVM 
switch selected in the sidebar.

Note: 1. The WinClient and Java Client AP programs have a hidden Control Panel at the 
upper center of the screen that becomes visible when you move the mouse over it. The 
Browser's Control Panel only appears after you switch to a port. 

Connecting to a Port
All the devices, ports, and outlets that a user is permitted to access are listed in the Sidebar at the left of 
the page.

•  To connect to a port when a device is selected in the Sidebar:
Double click its icon in the Sidebar, double click anywhere on its line entry in the main central 
panel, or select it in the main panel and click Connect at the bottom right of the page.

•  To connect to a port when the port is selected in the Sidebar, click Connect at the right of the 
Status panel (see “Status” on page 41).

Once switched to a port, its screen displays on your monitor, and your keyboard and mouse input affects 
the remote server.

Port Toolbar
The switch provides a toolbar to help with port switching operations from within the captured port. To 
open the toolbar, tap the GUI Hotkey (Scroll Lock is the default), twice. The toolbar opens at the upper 
left corner of the screen.

Depending on the settings selected for ID Display, the Port Number and/or the Port Name display at the 
right of the toolbar. 

When the toolbar displays, mouse input is confined to the toolbar area and keyboard input has no effect 
on the server connected to the port. To carry out server operations, close the toolbar by clicking its X 
icon.

To return to the Port Access Connections page, click the icon, or tap the GUI hotkey again.

Note: 1. Toolbar transparency can be adjusted (see “Video Settings” on page 30). 
2. The toolbar functions and icons are also incorporated in the Control Panel. Functions 
enabled in the Control Panel can be disabled the Toolbar. To recall the Port Access 
Connections page when there is no Toolbar, tap the GUI hotkey twice.
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Toolbar icons 

Toolbar Hotkey Port Switching

When the toolbar is displayed, hotkeys can be used to provide KVM focus to a port directly from the 
keyboard. 

•  Go directly to a port by entering its port number and clicking Enter.
•  Auto Scanning
•  Skip Mode Switching

The hotkeys are A and P for Auto Scanning and the Arrow Keys for Skip Mode.

Note: 1. The toolbar must be visible for hotkey operations to work.
2. To use the keys designated as hotkeys for normal purposes, close the toolbar.

Auto Scanning

The Scan function switches at regular intervals among all ports accessible to the currently logged on user 
to automatically monitor activity. Users can also limit the number of ports scanned with the Filter 
function of the Sidebar. See “Scan” on page 40, and “Filter” on page 40, for more details.

•  Setting the Scan Interval: The amount of time Auto Scan dwells on each port is set with the Scan 
Duration setting (page 51).

•  Invoking Auto Scan: With the toolbar open, tap the A key. Auto Scan cycles through the ports in 
order, starting at the first port on the installation. An S appears in front of the Port ID Display to 
indicate that the port is being accessed under Auto Scan Mode.

Icon Purpose

Click to skip to the first accessible port on the entire installation without recalling the Port Access 
page.

Click to skip to the first accessible port previous to the current one without recalling the Port Access 
page.

Click to begin Auto Scan Mode. The KVM switch automatically switches among the ports selected for 
Auto Scanning with the Filter function. This allows activity monitor without switching among them 
manually.

Click to skip from the current port to the next accessible one, without having to recall the Port Access 
page.

Click to skip from the current port to the last accessible port on the entire installation without recalling 
the Port Access page.

Click to recall the Port Access page.

Click to close the toolbar.

Click to invoke Panel Array Mode.
Not available on KVM1116P at local console

Click to cycle through the Adapter cable choices (Short, Medium, Long) used to connect the device to 
the switch. Choice depends on the length of Cat 5e cable used for the connection. The line length on 
the icon changes to indicate the selection. 
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•  Pausing Auto Scan: Pause scanning to focus on a particular server by pressing P. While Auto 
Scanning is paused, the S in front of the Port ID blinks On and Off.
Pausing to keep the focus on a particular server can be more convenient than exiting Auto Scan 
Mode because when scanning resumes, it starts where it left off. If you exit and then restart Auto 
Scan Mode, the scanning starts over from the very first server on the installation.
To Resume Auto Scanning after a pause, press any key except [ESC] or the [SPACEBAR]. 

•  Exiting Auto Scan: While Auto Scan Mode is running, ordinary keyboard functions are 
suspended. Exit Auto Scan Mode in order to regain normal control of the keyboard. To exit Auto 
Scan Mode press [ESC] or the [SPACEBAR]. Auto Scanning stops when you exit Auto Scan Mode.

Skip Mode

Switch ports in order to monitor the servers manually. Dwell on a particular port for as long as needed as 
opposed to Auto Scanning, which automatically switches after a fixed interval. The Skip Mode hotkeys 
are the four Arrow keys. Their operation is explained in the table below: 

Recalling the Port Access Page
To dismiss the toolbar and bring back the Port Access page:

•  Tap the GUI Hotkey once.
•  From the toolbar, click the icon that recalls the Port Access page (see “Toolbar icons” on page 84).

When the toolbar closes, the Port Access Page opens.

GUI Hotkey Summary Table
The table presents a summary of GUI Hotkey actions after you have accessed a port. See “User 
Preferences” on page 51 to set the GUI Hotkey. 

Icon Purpose
Left Skips from the current port to the first accessible port previous to it.
Right Skips from the current port to the first accessible port that comes after it.
Up Skips from the current port to the very first accessible port on the installation.
Down Skips from the current port to the very last accessible port on the installation.

To Do This
Open the Toolbar Click the GUI Hotkey twice
Open the Port 
Access Page

The Toolbar is open Click the GUI Hotkey once
The Toolbar is not open Click the GUI Hotkey three times
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Keyboard Emulation
Mac Keyboard

The PC compatible (101/104 key) keyboard can emulate the functions of the Mac keyboard. The 
emulation mappings are listed in the table below.

Note: When using key combinations, press and release the first key (CTRL), then press and 
release the activation key.

PC Keyboard Mac Keyboard

[SHIFT] Shift

[CTRL] Ctrl

[CTRL] [1]

[CTRL] [2]

[CTRL] [3]

[CTRL] [4]

[ALT] Alt

[PRINT SCREEN] F13

[SCROLL LOCK] F14

=

[ENTER] Return

[BACKSPACE] Delete

[INSERT] Help

[CTRL]  F15
KVM Switch KVM2132P, KVM2116P, KVM1116P User Manual 86



87KVM Switch KVM2132P, KVM2116P, KVM1116P User Manual 

Sun Keyboard

The PC compatible (101/104 key) keyboard can emulate the functions of the Sun keyboard when the 
Control key [Ctrl] is used in conjunction with other keys. The corresponding functions are shown below.

Note: When using key combinations, press and release the first key (CTRL), then press and 
release the activation key.

PC Keyboard Sun Keyboard

[CTRL] [T] Stop

[CTRL] [F2] Again

[CTRL] [F3] Props

[CTRL] [F4] Undo

[CTRL] [F5] Front

[CTRL] [F6] Copy

[CTRL] [F7] Open

[CTRL] [F8] Paste

[CTRL] [F9] Find

[CTRL] [F10] Cut

[CTRL] [1]

[CTRL] [2]

[CTRL] [3]

[CTRL] [4]

[CTRL] [H] Help

Compose

Meta



Panel Array Mode 
Click the Panel icon on the toolbar to start Panel Array Mode. The screen is divided into up to 42 panels:

•  Each panel represents one of the switch's ports beginning with Port 1 at the upper left, and going 
from left to right; top to bottom.

•  Click Show More Ports, and Show Fewer Ports symbols on the panel array toolbar to select the 
number of panels in the array.

•  Panel Array scans each of the ports previously selected with the Filter function (see “Filter” on 
page 40). The panel’s border is highlighted while that port is the focus of the scan.

•  Only ports accessible to the user are displayed. Blank panels display for ports that are not 
accessible. 

•  If the server connected to a port is on line the screen displays in the panel, otherwise the panel is 
blank. 

•  Move the mouse over a panel to display information about the port (port name, online status, port 
access status, and resolution).

•  Access a server connected to a port by moving the mouse pointer over its panel and clicking. You 
switch to the server exactly as if you had selected it from the Port Access page.

Panel Array Toolbar
The panel array toolbar provides shortcut navigation and control of the panel array. The toolbar can be 
dragged anywhere on the screen. Move the mouse over an icon to show a "tooltip" ( a short description 
of the icon's function). 

Icon Purpose

Click and drag to move the toolbar.
Note: This icon is only available with the Windows Clients. To move the Java Client 
toolbars, click on any empty space and drag.

Pause panel scanning, leaving the focus on the panel that currently has it.

Move back four panels.

Move to the previous panel.

Move to the next panel.

Move ahead four panels.

Show More Ports: Increase the number of panels in the array.

Show Fewer Ports: Decrease the number of panels in the array.

Toggle 4/3 aspect ratio.

Exit Panel Array mode.
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Multiuser Operation 
The KVM switch supports multiuser operation. When multiple users simultaneously access the switch 
from client computers, the rules of precedence that apply are shown in the following table: 

Users and Buses 

KVM2132P / KVM2116P / KVM1116P switches support independent bus switching. With independent 
bus switching, if a user switches to a port that is being utilized by someone on a different bus, only the 
user that switched ports goes to the new port and the new bus. The other users on the original bus remain 
on the original port and original bus.

Note: 1. Independent bus switching does not work when Auto Scan Mode or Panel Array 
Mode is being used by one of the members of the bus.
2. If Enable First Rider Transfer is enabled (see page 68), only the first user on a bus can 
switch to an unaccessed port. Other users on the bus cannot switch ports unless there is a bus 
already connected to the port they want to access, or there is a free bus available.

Panel Array Mode should be set to display at least four panels or other users may only receive part of the 
picture.

Operation Rule
General Each bus is independent. Each user can open his own independent GUI Main Page.
Auto Scan Mode • If a user has invoked Auto Scan Mode, and another user logs on and is assigned to the same 

bus, at first the new user sees the GUI Main Page but, as soon as he accesses any port, he 
automatically enters Auto Scan Mode (since he is sharing the bus with the original user).

• Any user on the bus can halt Auto Scan Mode by recalling the GUI Main Page. When this 
occurs, Auto Scan Mode stops and all other users on the bus are switched to the port that 
was being accessed when Auto Scan Mode stopped.

Panel Array Mode • If a user has invoked Panel Array Mode (see page 88), and another user logs on and is 
assigned to the same bus as the first user, the new user sees the GUI Main Page. As soon as 
he accesses any port, he enters Panel Array Mode (since he is sharing the bus with the 
original user).

• Panel Array Mode continues until the original user stops it. (Administrators can override 
Panel Array Mode.)

• Only the user who starts Panel Array Mode can use Skip Mode (see page 85).
• Only the user who starts Panel Array Mode can switch ports. Other users automatically 

switch to the ports that the original user selects. If a user does not have access rights to the 
port that the original user has switched to, that user will not be able to view the port.

• Users can increase or decrease the number of panels they wish to view in Panel Array 
Mode; however, the picture quality may decrease as the number of panels increases.
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Log

Log Information
The Log Information page displays events and provides the time, severity, user, and description of each 
event. The sort order can be changed by clicking on the column headings. The log file tracks a maximum 
of 512 events. When the limit is reached, the oldest events are discarded as new events arrive. 

Filter. 
Narrow the log event display to events that occurred at specific times, contain specific words or strings, 
or involve specific users. When this function is accessed, the log filter dialog box appears at the bottom 
of the page. 

Button Explanation
Pause Clicking Pause stops the display of new events. When the display is paused the button changes to 

Resume. Click Resume to start displaying events again.
Clear Log Clicking Clear Log clears the log file.
Export Log Clicking Export Log lets you save the contents of the log to a file on your computer.
Filter Clicking Filter allows you to search for particular events by date or by specific words or strings, 

as described in the next section.

Item Description
Time Filter for events that occurred at specific times:

• Today Only: Only the events for the current day are displayed.
• Start Date/Time: Filters for events from a specific date and time to the present. Check the 

checkbox to open a calendar. Set the date and time for the filtering to start. All events from the 
Start date/time to the present are displayed.

• For the Web Browser interface, check the Start Date/Time, click inside the text box to open the 
calendar. After calendar choices are made, click the A icon at the lower right of the calendar 
panel.

• End Date/Time: Filters for events from a specific date and time to a specific date and time. 
Select the Start Date/Time, check End Date/Time to set the ending date and time.

• For the Web Browser interface, Check End Date/Time, then click inside the text box to open 
the calendar. After calendar choices are made, click the A icon at the lower right of the 
calendar panel.

Information* Filters for a particular word or string. Enter word or string into the Information text box. Only 
events containing that word or string are displayed. Wildcards (? for single characters and * for 
multiple characters) and the keyword “or” are supported. 

User Filters for specific users. Check the User checkbox, enter the user's Username, then click Apply. 
Only events containing that Username are displayed. 
Note: If the User checkbox is not checked in the Filter panel, the entire User column does not 
appear in the main panel.

Severity Filters based on the severity rating of the event. Least events appear in black, Less events 
appear in blue, Most events appear in red.
Put a check in the Severity checkbox, then check the severity options to filter. Only events that 
match the severity ratings specified appear in the display.
Note: If the Severity checkbox is not checked in the Filter panel, the entire Severity column 
does not appear in the main panel.

Apply Click to apply the filter choices.
Reset Click to clear the entries in the dialog box and start with a clean slate.
Exit Click to exit the log filter function.
* See page 59 for an example.
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Log Notification Settings
Select which events trigger a notification and how the notification are sent out. Notifications can be sent 
via SNMP trap, SMTP email, written to the SysLog file, or any combination of the three. A check mark 
indicates that notification of the event is enabled for the method specified in the column heading, an X 
indicates that notification is not enabled.

Note: In any of the columns, Shift-Click or Ctrl-Click to select a group of events. Clicking to 
enable/disable any one of them causes all of them to change in unison.
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Maintenance 
Upgrade firmware, backup and restore configuration and account information, ping network devices, and 
restore default values.

Main Firmware Upgrade
Upgrade the KVM switch's main firmware and upgrade any PDU units and Blade Servers deployed on 
the installation. New versions of the firmware can be downloaded from the website as they become 
available. Check the website regularly to find the latest information and packages.
To upgrade the main firmware:

1. Download the new firmware file (switch, PDU or blade server module) to your computer.
2. Log in to the KVM switch and click the Maintenance tab to open the Upgrade Main Firmware 

page.
3. Click Browse, navigate to the new firmware file, and select the file.
4. Click Upgrade Firmware.

– If you enabled Check Main Firmware Version the current firmware level is compared with 
that of the upgrade file. If the current version is equal to or higher than the upgrade version, a 
popup message appears to inform you and the upgrade procedure stops.

– If you did not enable Check Main Firmware Version, the upgrade file is installed without 
checking the level.

– As the upgrade proceeds, progress information is shown in the Progress bar.
– Following successful completion, the switch resets itself.

5. Log in again, and check that the new firmware version is installed.

Adapter Firmware Upgrade 
1. Log in to the KVM switch, click the Maintenance tab, and select Upgrade Adapters.
2. Click Adapter Firmware Info to open a list of adapter firmware versions. If the main firmware 

has been upgraded, newer versions than what is on the adapters may be listed.

3. Compare the versions stored in the main firmware with the versions listed in the F/W Version 
column of the Main Panel. If the versions stored in the firmware are newer than the versions on 
the adapters, perform the upgrade.

4. In the Name column of the Main Panel, check the ports whose adapters you want to upgrade.
5. Click Upgrade Adapters to start the upgrade.

– If Check Adapter Firmware Version was enabled, the current firmware level(s) are 
compared to the upgrade versions. If the current version is equal to, or higher than the upgrade 
version, a message appears in the adapter’s Progress column to announce that no upgrade is 
available and the upgrade stops. 

– If Check Adapter Firmware Version is not enabled, the upgrade installs without checking 
the level.

– The new adapter firmware version displays when the upgrade is finished.
Note: 1. For optimum compatibility, upgrade Adapter Cable firmware to that stored with the 
switch's Main firmware.
2. Perform the upgrade when an adapter is added to the installation to ensure the latest 
firmware version is used.
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Update Adapter Display Info. Read display information (ex: brand/type/EDID) for monitor. Write 
display information to server modules so that computers can identify the monitor connected at console 
ports. This is only necessary to set to unique resolution level provided by the monitor.

Firmware Upgrade Recovery
If the switch's main firmware upgrade procedure fails, and the switch becomes unusable: 

1. Power off the switch.
2. Press and hold the Reset Switch in (see page 7).
3. While holding the Reset Switch in, power the switch back on.

The switch reverts to the original factory installed main firmware version. Once the switch is 
operational, try the upgrade again.

Adapter Firmware Upgrade Recovery
If the adapter firmware upgrade procedure fails for one of the KVM Adapter Cables and the adapter 
becomes unusable:

1. Unplug the Adapter from the server it is connected to.
2. Slide its Firmware Upgrade Recovery Switch (located next to the Cat 5e connector) to the 

RECOVER position.
3. Plug the Adapter back into the server.
4. Repeat the Adapter upgrade procedure.
5. After the Adapter has been successfully upgraded, unplug the Adapter from the server. 

Slide the Firmware Upgrade Recovery Switch back to the NORMAL position. 
Plug the Adapter back into the server.

Backup/Restore 
Backup

1. Enter a password for the file in the Password field.
Note: 1. A password is optional. If one has not been set, the file can be restored 
without specifying a password. 
2. If a password is set, make a note of it. It is necessary to restore the file.

2. Click Backup.
3. When the browser asks what to do with the file, select Save to disk. (Save in a convenient 

location.) 

Restore
1. Click Browse, navigate to the file, and select it.

Note: If you renamed the file, there is no need to return it to its original name.

2. If you set a password when you created the file, enter it.
3. Select the options to restore.
4. Click Restore.

After the file is restored, a message appears to inform you that the procedure succeeded.
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Ping
Check the network status of devices on the KVM switch installation with Ping.

1. Enter the IP Address or Host Name of the switch into the text entry box.
2. Click OK.

The ping results display in the Result panel.

Restore Values
Restore configuration changes made to the KVM switch to their original factory default values.

Clear Port Names. Removes names that have been assigned to the ports

Restore Default Values. Removes all changes made to the KVM switch (except for the Port Names), 
including the Network Transfer Rate (on the Network page). The parameters return to the original 
factory default settings.

Reset on exit
Place a check in the checkbox and click Apply to have the KVM switch reset itself and implement all the 
new settings when you log out. (Wait approximately 30 to 60 seconds before logging back in.) If the 
switch's IP Address is changed, the checkbox is automatically checked and the KVM switch will reset 
when you log out. If the check mark is cleared before logging out, the changed IP settings will be ignored 
and the original IP address settings will remain in effect.

Note: If the check mark was cleared, the changed IP settings are ignored, but still remain in 
the network settings fields. The Reset on exit checkbox will automatically be enabled the 
next time the page is opened. When the switch resets, the discarded IP settings will be used 
by the switch. To avoid a problem, go to the network settings page and see that the correct IP 
settings are in the fields.

The Download Tab
To download stand-alone AP versions of the Windows Client, the Java Client, and the Log Server to your 
computer’s hard drive: 
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The Log Server
The Windows-based Log Server is an administrative utility that records all the events that take place on 
selected KVM switches and writes them to a searchable database. 

Installation

1. Log into the KVM switch (see page 17).
2. Click the Download tab and download the Log Server AP program to your computer.
3. Go to the location on your hard drive and double click LogSetup.exe to open the Windows Client 

Connection Screen.
4. When the Log Server installation screen opens, click Next. Then follow the on-screen 

instructions to complete the installation and place the Log Server program icon on your desktop.

Starting Up

To start the Log Server, double click the program icon, or enter the full path to the program on the 
command line. 

Note: 1. The MAC address of the Log Server computer must be specified in the ANMS 
settings.
2. The Log Server requires the Microsoft Jet OLEDB 4.0 driver. See Log Server in the 
Troubleshooting section on page 119 if the program doesn't start.

The screen is divided into three components.

•  A Menu Bar at the top
•  A panel containing a list of KVM switches in the middle.
•  A panel containing an Events List at the bottom

The Menu Bar

Note: If the Menu Bar appears to be disabled, click in the List window to enable it.

Configure. The Configure menu contains three items: Add; Edit; and Delete. They are used to add new 
units to the List, edit the information for units already on the list, or delete units from the list.

•  To add a unit to the list, click Add.
•  To edit or delete a listed unit, first select the target in the List window, then open the menu and 

click Edit or Delete.
Choose Add or Edit to open a dialog box. Fill in or modify the fields, then click OK to finish. 

Field Explanation
Address The IP address of the computer on which the Log Server is running, or its DNS name.
Port The port number that was assigned to the Log Server under Device Management (see “Log 

Server” on page 71).
Description Enter a descriptive reference for the unit to help identify it.
Limit Specify the number of days an event should be kept in the Log Server's database. Events that 

exceed the amount of time specified can be removed (see “Maintenance” on page 92).
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Events. 
The Events Menu has two items: Search and Maintenance.

Search: Search for events containing specific words or strings. 

Maintenance. Allows the administrator to perform manual maintenance of the database, such as erasing 
specified records before their expiration time is up.

Options. Network Retry: Set the amount of time that the Log Server should wait before attempting to 
reconnect following a failed attempt. Click to open the dialog box. Enter the number of seconds. Click 
OK to finish. 

Help. From the Help menu, click Contents to access the online Windows Help file. The help file 
contains instructions for setup, operation, and troubleshooting of the Log Server.

The Log Server Main Screen

Overview. The Log Server Main Screen is divided into two main panels.

•  The upper (List) panel lists all of the switches that have been selected for the Log Server to track 
(see “Log” on page 90).

•  The lower (Event) panel displays the event information for the currently selected unit. (If there are 
multiple switches, the selected switch is highlighted).

•  Click on a unit in the list to select.

Item Description
New search One of three radio buttons that define the scope of the search. Select to search all 

events in the database for the selected unit.
Search last results A secondary search performed on the results of the previous search.
Search excluding 
last results

Perform a secondary search of all events in the database for the selected unit 
excluding the results of the previous search.

Server List KVM switches are listed according to their IP address. Select the unit to search 
from this list. More than one unit can be selected. If no units are selected, the 
search is performed on all of them.

Priority Set the level of detail for the search results display. Least is the most general; Most 
is the most specific. Least results appear in black; Less results appear in blue; Most 
results appear in red.

Start Date Select the start date of the search. The format follows the YYYY/MM/DD 
convention (Example: 2011/11/04).

Start Time Select the start time of the search. The format follows the HH:MM:SS convention.
End Date Select the end date of the search.
End Time Select the end time of the search.
Pattern Enter the pattern you are searching for here. The multiple character wildcard (%) 

is supported. 
Results Lists the events that matched the search.
Search Click to start the search.
Print Click to print the search results.
Export Click to save the search results to file.
Exit Click to exit the Log Server.
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The List Panel. The List panel contains six fields: 

The Event Panel. The lower panel displays log events for the currently selected unit. Multiple units 
may be recording if their checkbox is checked even when they aren't currently selected for display. The 
Log Server records their events and keeps them in its database.

LDAP Server Configuration
Introduction

The KVM switch allows log in authentication and authorization through external programs. To allow 
authentication and authorization via LDAP or LDAPS, the Active Directory's LDAP Schema must be 
extended so that an extended attribute name for the KVM switch (Example: iKVM2132P- uuserprofile-) 
is added as an optional attribute to the person class.

Note: Authentication refers to determining the authenticity of the person logging in. 
Authorization refers to assigning permission to use the device's various functions.

In order to configure the LDAP server, you will have to complete the following procedures:

1. Install the Windows Server Support Tools 
2. Install the Active Directory Schema Snap-in and 
3. Extend and Update the Active Directory Schema

Configuring LDAP under Windows 2003 Server.

Install the Windows 2003 Support Tools. To install the Windows 2003 Support Tools:

1. On your Windows Server CD, open the Support >Tools folder.
2. In the right panel of the dialog box that opens, double click SupTools.msi.
3. Follow the Installation Wizard to complete the procedure.

Field Explanation
Recording Put a check in the checkbox if you want the Log Server to record events for this unit. If the 

Recording checkbox is checked, the field displays Recording. If the Recording checkbox 
is not checked, the field displays Paused and events are not recorded.
Note: Even if a unit is not the currently selected one, if its Recording checkbox is 
checked, the Log Server will still record its events.

Address The IP Address or DNS name that was given to the unit when it was added to the Log 
Server. (See “Configure” on page 95.) 

Port The Access Port number assigned to the unit.
Connection • If the Log Server is connected to the unit, this field displays Connected.

• If the Log Server is not connected, this field displays Waiting. The Log Server's MAC 
address has not been set properly. Set it on the Device Management Date/Time page on 
page 67.

Days The number of days that the unit's log events are kept in the Log Server's database before 
expiration.

Description Display the descriptive information given for the unit when it was added to the Log Server.
97KVM Switch KVM2132P, KVM2116P, KVM1116P User Manual 



Install the Active Directory Schema Snap-in. 
1. Open a Command Prompt.
2. Enter: regsvr32 schmmgmt.dll to register schmmgmt.dll on your Active Directory computer.
3. Open the Start menu; 

Click Run. 
Enter: mmc /a 
Click OK.

4. On the File menu of the screen that appears, click Add/Remove Snap-in; then click Add.
5. Under Available Standalone Snap-ins, double click Active Directory Schema. 

Click Close. 
Click OK.

6. On the screen you are in, open the File menu and click Save.
7. For Save in, specify the C:\Windows\system32 directory.
8. For File name, enter schmmgmt.msc.
9. Click Save to finish.

Create a Start Menu Shortcut Entry. 
1. Right click Start. Select Open all Users > Programs > Administrative Tools.
2. On the File menu, select New > Shortcut.
3. In the dialog box that opens, browse to, or enter the path to schmmgmt.msc 

(C:\Windows\system32\schmmgmt.msc), then click Next.
4. In the dialog box that opens, enter Active Directory Schema as the name for the shortcut, then 

click Finish.
Extend and Update the Active Directory Schema. 

1. Create a new attribute. 
2. Extend the object class with the new attribute.
3. Edit the active directory users with the extended schema.
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Creating a New Attribute. 
1. From the Start menu, open Administrative Tools > Active Directory Schema.
2. In the left panel of the screen that opens, right-click Attributes.
3. Select New > Attribute.
4. In the warning message that opens, click Continue to open the Create New Attribute dialog box.
5. Fill in the dialog box to match the entries for Description and Common Name shown below, then 

click OK to complete the procedure.

Note: The Unique X500 Object ID uses periods, not commas.
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Extend the Object Class With the New Attribute. 

1. Open the Control Panel > Administrative Tools > Active Directory Schema.
2. In the left panel of the screen that opens, select Classes.
3. In the right panel, right-click person.
4. Select Properties. The person Properties dialog box opens with the General page displayed. 

Click the Attributes tab.
5. On the Attributes page, click Add.
6. In the list that opens, select  iKVM2132P-userprofile, then click OK to finish.



Editing Active Directory Users. To edit Active Directory Users With the Extended Schema:

1. Run ADSI Edit. (Installed as part of the Support Tools.)
2. In the left panel, open Domain, and navigate to the DC=aten,DC=com CN=Users node.
3. In the right panel, locate the user you wish to edit. 
4. Right-click on the user's name and select properties.
5. On the Attribute Editor page of the dialog box, select iKVM4140-userprofile from the list. 

6. Click Edit to open the String Attribute Editor:
7. Enter the KVM permission attribute values. 

Note: User represents the Username of a KVM user whose permissions reflect the 
permissions you want the new user to have (see“Users” on page 59).
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8. Click OK. Return to the Attribute Editor page. The iKVM4140-userprofile entry now reflects 
the new permissions. Click Apply to save the change and complete the procedure. The new user 
now has the same permissions as user. Repeat to add other users.

OpenLDAP

OpenLDAP is an Open source LDAP server designed for Unix platforms.

OpenLDAP Server Installation. Download and install the program. The default directory is: 
c:\Program Files\OpenLDAP.

Select install BDB-tools and install OpenLDAP-slapd as NT service.

OpenLDAP Server Configuration. Customize the main OpenLDAP configuration file, slapd.conf, (in 
the /OpenLdap directory) before launching the server. Modifications to the configuration file are 
necessary in order for it to be used with the KVM switch.

•  Specify the Unicode data directory. The default is ./ucdata.
•  Choose the required LDAP schemas. The core schema is mandatory.
•  Configure the path for the OpenLDAP pid and args start up files. The first contains the server pid, 

the second includes command line arguments.
•  Choose the database type. The default is bdb (Berkeley DB).
•  Specify the server suffix. All entries in the directory will have this suffix, which represents the 

root of the directory tree. For example, with suffix dc=apc,dc=com, the fully qualified name of all 
entries in the database will end with dc=apc,dc=com.

•  Define the name of the administrator entry for the server (rootdn), along with its password 
(rootpw). This is the server's super user. The rootdn name must match the suffix defined above. 
(Since all entry names must end with the defined suffix, and the rootdn is an entry.)

Starting the OpenLDAP Server. To start the OpenLDAP Server, run slapd (the OpenLDAP Server 
executable file) from the command line. slapd supports a number of command line options, the most 
important option is the d switch that triggers debug information. For example, a command of slapd -
d 256 would start OpenLDAP with a debug level of 256.
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Customizing the OpenLDAP Schema. The schema that slapd uses may be extended to support 
additional syntaxes, matching rules, attribute types, and object classes. The User class and the 
permission attribute are extended to define a new schema to work with the KVM switch. 

LDAP DIT Design and LDIF File. LDAP Data Structure. An LDAP Directory stores information in 
a tree structure known as the Directory Information Tree (DIT). The nodes in the tree are directory 
entries, and each entry contains information in attribute-value form. The LDAP Data Interchange Format 
(LDIF) is used to represent LDAP entries in a simple text format. The name of the file is init.ldif and you 
create it in the /OpenLDAP directory.

Using the New Schema. 

1. Save the new schema file in the /OpenLDAP/schema/ directory.
2. Add the new schema to the slapd.conf file (in the /OpenLDAP directory).
3. Restart the LDAP server.
4. Write the LDIF file and create the database entries in init.ldif with the ldapadd command.

Example: ldapadd -f init.ldif -x -D "cn=ldapadmin,dc=aten,dc=com"-w password

Factory Default Settings
Setting Default
Language English
GUI Hotkey [Scroll Lock] [Scroll Lock]
Port ID Display Port Number + Name
Port ID Display Duration 3 Seconds
Scan Duration 5 Seconds
Screen Blanker 0 Minutes (disabled)
Beeper On
Viewer Auto Detect
Welcome Message Hide
Accessible Ports • Super Administrators - Full for all ports

• All other users - None for all ports.
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Serial Adapter Pin Assignments
KVM KVM2132P / KVM2116P / KVM1116P 

Supported KVM Switches
Supported KVM switches that can be used in a tiered installation:

•  KVM2132P / KVM2116P
– KVM0216A

•  KVM1116P
– KVM0108A / KVM0116A

Note: 1. Some of the KVM switch's features may not be supported, depending on the 
functionality of the tiered KVM switch. (For example, KVM0108A / KVM0116A switches 
do not support virtual media.) 

Supported PDUs
KVM2132P / KVM2116P only

Supported PDUs that can be connected to the KVM switch:

•  AP79xx
•  AP89xx
•  AP86xx

RJ45-F to DB9-M (Black Connector) DTE to DCE
 (RJ45) Pins (8) <--------> Modem/Device

(DB9)
RTS 1 <--------> 7
DTR 2 <--------> 4
TXD 3 <--------> 3
CTS 4 <--------> 8
GND 5 <--------> 5
RXD 6 <--------> 2
DCD 7 <--------> 1
DSR 8 <--------> 6

9 NC not used 
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Virtual Media Support
WinClient ActiveX Viewer / WinClient AP

•  IDE CDROM/DVD-ROM Drives - Read Only
•  IDE Hard Drives - Read Only
•  USB CDROM/DVD-ROM Drives - Read Only
•  USB Hard Drives - Read/Write*
•  USB Flash Drives - Read/Write*
•  USB Floppy Drives - Read/Write 

* These drives can be mounted either as a Drive or as a Removable Disk (see “Virtual Media” on 
page 32). Removable disks allow the user to boot the remote server if the disk contains a bootable 
OS. If the disk contains more than one partition, the remote server can access all the partitions.

•  ISO Files - Read Only
•  Folders - Read/Write

Java Applet Viewer / Java Client AP

•  ISO Files - Read Only
•  Folders - Read/Write

IP Address Determination
Log in to the KVM switch as administrator the first time and give it an IP address for connection by 
users. Your client computer must be on the same network segment as the KVM switch. Connect and log 
in to give the KVM switch its fixed network address. 

The Local Console. The easiest way to assign an IP address is from the local console. Refer to “First 
Time Setup” on page 17, for details on the procedure involved.

IP Installer

For client computers running Windows, an IP address can be assigned with the IP Installer utility. The 
utility can be obtained from the www.apc.com. Download the utility to your client computer.

1. Unzip the contents of IPInstaller.zip to a directory on your hard drive.
2. Go to the directory where you saved the IP Installer program to and run IPInstaller.exe. A dialog 

box will open.
3. Select the KVM switch in the Device List.

Note: 1. If the list is empty, or your device doesn't appear, click Enumerate to 
refresh the Device List.
2. If there is more than one device in the list, use the MAC address to pick the one you 
want. The KVM switch's MAC address is located on its bottom panel.
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4. Select either Obtain an IP address automatically (DHCP), or Specify an IP address. If you chose 
the latter, fill the IP Address, Subnet Mask, and Gateway fields with the information appropriate 
to your network.

5. Click Set IP.
6. After the IP address shows up in the Device List, click Exit. 

Browser

1. Set your client computer's IP address to 192.168.0.XXX where XXX represents any number or 
numbers except 60. (192.168.0.60 is the default address of the KVM switch.)

2. Specify the switch's default IP address (192.168.0.60) in your browser to be able to connect.
3. Assign a fixed IP address for the KVM switch that is suitable for the network segment on which 

it resides.
4. After logging out, reset your client computer's IP address to its original value.

IPv6

The KVM switch supports three IPv6 address protocols: Link Local IPv6 Address, IPv6 Stateless 
Autoconfiguration, and Stateful Autoconfiguration (DHCPv6).

Link Local IPv6 Address. The KVM switch is automatically configured with a Link Local IPv6 
Address (for example, fe80::210:74ff:fe61:1ef). To find out what the Link Local IPv6 Address is, log in 
with the KVM switch's IPv4 address and open the Device Management > Device Information page. The 
address is displayed in the General list box.

Once the IPv6 address has been determined, it can be used when logging in from a browser or the Win 
and Java Client AP programs. For example: If you are logging in from a browser, enter http://
[fe80::2001:74ff:fe6e:59%5] for the URL bar. If you are logging in with the AP program, enter: 
fe80::2001:74ff:fe6e:59%5 for the IP field of the Server panel.

Note: 1. To log in with the Link Local IPv6 Address, the client computer must be on the 
same local network segment as the KVM switch.
2. The %5 is the %interface used by the client computer. To see your client computer's IPv6 
address: from the command line issue the following command: ipconfig /all. The % value 
appears at the end of the IPv6 address.

IPv6 Stateless Autoconfiguration. If the KVM switch's network environment contains a device (such 
as a router) that supports the IPv6 Stateless Autoconfiguration function, the KVM switch can obtain its 
prefix information from that device in order to generate its IPv6 address. For example, 
2001::74ff:fe6e:59.

The address is displayed in the General list box of the Device Management > Device Information page. 
Once the IPv6 address has been determined, it can be used when logging in from a browser or the Win 
and Java Client AP programs. For example: If you are logging in from a browser, enter http://
[2001::74ff:fe6e:59] for the URL bar. If you are logging in with the AP program, you would enter: 
2001::74ff:fe6e:59 for the IP field of the Server panel (see “Windows Client AP Login” on page 20).

Port Forwarding 

For devices located behind a router, port forwarding allows the router to pass data coming in over a 
specific port to a specific device. By setting the port forwarding parameters, you tell the router to which 
device the data that comes in over a particular port is sent.
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For example, if the KVM switch has an IP address of 192.168.1.180, log into your router's setup program 
and access the Port Forwarding (sometimes referred to as Virtual Server) configuration page. Specify 
192.168.1.180 for the IP address and the port number you want opened for it (9000 for internet access, 
for example).

Configuration setup can vary. Refer to the router's User Manual for specific information on configuring 
port forwarding.

PPP Modem Operation

An external modem (customer supplied) is used with the KVM switch. An APC serial adapter (provided) 
connects the switch to the modem. 

Basic Setup. The KVM switch can be accessed through its RS-232 port using a PPP dial-in connection:
1. Set up your hardware configuration to match the diagram:

2. From your client computer, use your modem dial-in program to dial into the KVM switch's 
modem.

Note: If you don't know the KVM switch modem's serial parameters, get them from 
the KVM administrator.

3. Once a connection is established, open your browser, and specify 192.168.192.1 in the URL box.
4. The default username and password are blank.
5. For the modem session, the KVM switch has an IP address of 192.168.192.1; the user side has an 

IP address of 192.168.192.101.
6. From here, operation is the same as if you had logged in from a browser or with the AP programs.
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LAN 2 PDU 2

LAN 1 PDU 1

Adapter

Modem

Modem

Remote
User
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Connection Setup Example (Windows XP)
To set up a dial-in connection to the KVM switch under Windows XP:

1. From the Start menu, select Control Panel > Network Connections > Create a New Connection.
2. When the Welcome to the New Connection Wizard dialog box opens, click Next.
3. In the Network Connection Type dialog box, select Connect to the network at my workplace, 

then click Next.
4. In the Network Connection dialog box, select Dial-up connection, then click Next.
5. In the Connection Name dialog box, key in a name for the connection (Example: TPE-

KVM2132P-01), then click Next.
6. In the Connection Availability dialog box, select Anyone's use or My use only, then click Next. 

If you are the only user on this client computer, this dialog box will not appear.
7. In the Phone Number to dial dialog box, enter the phone number of the modem connected to the 

KVM switch (include country and area codes, if necessary), then click Next.
8. In the Completing the New Connection Wizard dialog box, check Add a shortcut to this 

connection on my desktop, then click Finish. This completes the connection setup. Double click 
the desktop shortcut icon to make a PPP connection to the KVM switch.

Additional Mouse Synchronization Procedures 
To use Manual Mouse Synchronization, perform the following operations on the servers that connect to 
the switch.

Note: 1. These procedures are performed on the servers attached to the switch's ports, not on 
the client computer you are using to access the KVM switch.
2. In order for the local and remote mice to synchronize, use the generic mouse driver 
supplied with the Windows operating system. Third party drivers (supplied by the mouse 
manufacturer) must be removed.

Windows. 

1. Windows 2000:
a. Open the Mouse Properties dialog box (Control Panel > Mouse > Mouse Properties)
b. Click the Motion tab
c. Set the mouse speed to the middle position (6 units in from the left)
d. Set the mouse acceleration to None

2. Windows XP / Windows Server 2003:
a. Open the Mouse Properties dialog box (Control Panel > Mouse).
b. Click the Pointer Options tab.
c. Set the mouse speed to the middle position (6 units in from the left).
d. Disable Enhance Pointer Precision.

3. Windows ME: Set the mouse speed to the middle position; disable mouse acceleration (click 
Advanced to open the dialog box).

4. Windows NT / Windows 98 / Windows 95: Set the mouse speed to the slowest position.
Sun / Linux. Open a terminal session and issue the following command:

Sun: xset m 1
Linux: xset m 0 or xset m 1 (If one doesn't help, try the other.) 
Linux using the Redhat AS3.0 mouse mode: xset m 1 
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Fan Location and Speed Information
KVM2132P / KVM2116P only

Fan Location

The KVM switch has 4 fans that feed realtime fan speed information to the WinClient / Java Client 
Device Management page. The fan speed is shown on the Device Information web page. 

Fan Speed

Fan speed automatically adjusts according to temperature as follows:

•  If any sensor senses that the temperature is greater than 32° C, all fans spin at half speed .
•  If any sensor senses that the temperature is greater than 45° C, all fans spin at full speed.
•  When all four sensors sense that the temperature is less than 40° C, all fans return to half speed.
•  When all four sensors sense that the temperature is less than 30° C, all fans turn off.

Note: Fan half speed equals 2500 rpm. Fan full speed equals 5000 rpm.

Temperature Sensor Location and Information
KVM2132P / KVM2116P only

The KVM switch has 4 temperature sensors on its mainboard that feed realtime temperature updates to 
the WinClient / Java Client Device Management page. See Device Information, Temperature on page 67 
for more information. 

Note: The temperature inside the case can be higher than the ambient temperature (0-50° C). 
IC chips can tolerate temperatures of up to 105°C. If the temperature reading rises past 85° C, 
make the ambient temperature cooler or, shut the switch down until it cools off.

KVM-SERIAL Server Module Configuration and 
Operation

The KVM-SERIAL cable connects a serial device to the KVM switch.

Configuration

To configure the KVM-SERIAL Server Module to interact with the connected device, set its serial 
parameters to match the parameters of the device:

1. In the Port Access page Sidebar, select the port to which the KVM-SERIAL Server Module is 
connected.

2. Select Port Configuration on the menu bar. The page opens with the Port Properties tab 
selected.
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3. In the Properties section, select the port property values that match those used by the connected 
serial console device. 
The Module supports these port property settings: 

4. When you have finished making your selections, click Save.

Operation

To operate the device connected to the port, in the Port Access page double click the port to establish a 
serial connection to the device.

Internal Serial Interface Configuration
To configure an attached device's serial interface parameters from within any accessed server. 

1. From the accessed server, open a command line (terminal) session or third party serial application 
such as HypterTerminal or PuTTY.

2. Telnet or SSH to the KVM switch's IP address.
3. Log in with your usual Username and Password to bring up the access screen.

Navigation

The left panel shows the KVM switch at the top, and all the serial interface devices connected to it listed 
below. The right panel shows the configuration parameters at the top, with the configuration settings in 
the area below.

Use the Left and Right Arrow keys to move the highlight bar between the right and left panels and to 
select the parameter to configure.

Use the Up and Down Arrow keys to select among the switch and the serial devices in the left panel and 
to select the configuration items in the right panel.

Setting Meaning
Bits per second
(Baud Rate)

Sets the port's data transfer speed. Choices are from 300-38400 (drop down the list 
to see them all). Set this to match the baud rate setting of the serial console device. 
Default is 9600 (which is a basic setting for many serial console devices).

Data Bits Sets the number of bits used to transmit one character of data. Choices are: 7 and 8. 
Set this to match the data bit setting of the serial console device. Default is 8 
(which is the default for the majority of serial console devices).

Parity Checks the integrity of the transmitted data. Choices are: None; Odd; Even. Set this 
to match the parity setting of the serial console device. Default is Odd.

Stop Bits Indicates that a character has been transmitted. Set this to match the stop bit setting 
of the serial console device. Choices are: 1 and 2. Default is 1 (which is the default 
for the majority of serial console devices).

Flow Control Choose how the data flow will be controlled. Choices are: None, Hardware, and 
XON/XOFF. Set this to match the flow control setting of the serial console device. 
Default is None. 
Note: None is only supported for baud rates of 9600 and lower. For baud rates 
greater than 9600, you must choose Hardware or XON/XOFF.

Access Mode Set the serial console device's access mode. Choices are: Share, Occupy, and 
Exclusive. Default is Share. See “Access Mode” on page 39 for information 
regarding this function.
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Operation

Use the Up and Down Arrow keys to highlight a device in the left panel, then press [ENTER] to open a 
command line (terminal) session on the accessed device.

When you have finished with your session, press the hotkey (see page 111) that brings you back to the 
access page.

To finish with this function, move the highlight bar to Logout in the right panel of the access page; Press 
the Down Arrow key to highlight Exit, then press [ENTER].

Switch Level Configuration

The configuration settings that are available when the KVM switch is selected in the left panel are: 

Port Level Configuration

The configuration settings that can be made when a serial interface device is selected: 

Setting Description
Port 
Configuration

When Port Configuration is selected, press the Down Arrow key to highlight the current 
timeout setting. Enter a new timeout number to overwrite the current one. Note: There is no 
way to erase the number entered. To change it, use the Up Arrow key to leave the field then use 
the Down Arrow to come back to it. After you come back, enter the new number. When you 
have finished, use the Down Arrow to highlight Save, then press [ENTER]. 

User Preference Set a hotkey that brings you back to the access screen from the session you are working in. 
When User Preferences is selected, press the Down Arrow key to highlight the current hotkey 
letter. Enter the new letter to overwrite the current one. When you have finished, use the Down 
Arrow to highlight Save, then press [ENTER].

Logout When Logout is selected, press the Down Arrow key to highlight Exit, then press [ENTER].

Setting Description
Port 
Configuration

To configure the serial parameters:
1. Use the Up and Down Arrow keys to highlight the target item.
2. Press [ENTER] to open the list of choices.
3. Use the Up and Down Arrow keys to highlight your choice, then press [ENTER]. When you 
have finished, press the Down Arrow key to highlight Save, then press [ENTER].

User Preference Set a hotkey that brings you back to the access screen from the session you are working in. 
When User Preferences is selected, press the Down Arrow key to highlight the current hotkey 
letter. Enter the new letter to overwrite the current one.
When you have finished, use the Down Arrow to highlight Save, then press [ENTER].

Logout When Logout is selected, press the Down Arrow key to highlight Exit, then press [ENTER].
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Trusted Certificates
Overview

When you try to log in to the device from your browser, a Security Alert message appears to inform you 
that the device's certificate is not trusted, and asks if you want to proceed.
The certificate can be trusted, but the alert is triggered because the certificate's name is not found on the 
Microsoft list of Trusted Authorities. You have two options. You can ignore the warning and click Yes to 
go on or you can install the certificate and have it be recognized as trusted.
If you are working on a client computer at another location, accept the certificate for just this session by 
clicking Yes.
If you are working at your own client computer, install the certificate on your client computer. After the 
certificate is installed, it will be recognized as trusted.

Installing the Certificate

1. In the Security Alert dialog box, click View Certificate to open the Certificate Information 
dialog box.

Note: There is a red and white X logo over the certificate to indicate that it is not 
trusted.

2. Click Install Certificate.
3. Follow the Installation Wizard to complete the installation. Unless you have a specific reason to 

choose otherwise, accept the default options.
4. When the Wizard presents a caution screen, click Yes.
5. Click Finish to complete the installation, then click OK to close the dialog box

Certificate Trusted. Click View Certificate, to see that the red and white X logo is no longer present. 

Mismatch Considerations. If the site name or IP address used for generating the certificate no longer 
matches the current address of the switch a mismatch warning opens. Click Yes to go on, or disable 
mismatch checking. To disable mismatch checking: 

1. After the page you are logging in to comes up, open the browser's Tools menu. 
Select Internet Options > Advanced. 

2. Scroll to the bottom of the list and uncheck Warn about trusted certificates. 
3. Click OK. The next time the browser is opened, the change will be in effect.

Self-Signed Private Certificates
To create your private key and certificate:

1. To create a self signed certificate, you will first need to create a Certificate Signing Request 
(CSR). See “Certificate Signing Request” on page 79 for details. 

2. Downloaded openssl.exe and save it to \OpenSSL\bin on your hard drive.
– Create the SSL certificate using OpenSSL. OpenSSL 1.0.0d was tested and is available from 

http://www.openssl.org for Unix based systems. A Windows based version is located at the 
following website: http://www.openssl.org/related/binaries.html. No other programs l work for 
creating SSL certificates for the KVM Switches. 
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3. Save the CSR from the KVM. (Save the csr.cer into the OpenSSL installation folder 
\OpenSSL\bin)

4. Move the directory "demoCA" into "bin" within the OpenSSL installation directory and add 
directory "newcerts" in"demoCA"

5. Under the command prompt window, change the directory to \OpenSSL\bin and execute the 
following commands in the command prompt:

a. openssl req -new -newkey rsa:1024 -days 3365 -nodes -x509 -keyout ca.key -out ca.cer
b. openssl.exe ca -policy policy_anything -config openssl.cfg -cert ca.cer -in csr.cer -keyfile 

ca.key -days 360 -out new.cer
Note: 1. Commands should be entered all on one line. (Do not press [ENTER] until all the 
parameters have been entered).
2. If there are spaces in the input, surround the entry in quotes. Example: (apc by schneider-
electric).

To avoid having to input information during key generation the following additional parameters can be 
used: /C /ST /L /O /OU /CN /emailAddress. 

Importing the Files. After the openssl.exe program completes, two files, CA.key (the private key) and 
CA.cer (the self-signed SSL certificate), are created in the directory. These are the files that you upload 
in the Private Certificate panel of the Security page (see “Security” on page 75, and “Private Certificate” 
on page 78).

If you encounter "Failed to update database, TXT_DB error number 2," you will need to edit a text file in 
the OpenSSL program directory before continuing. The file "index.txt.attr" in the "demoCA" directory 
will be generated after you run command "b" from step 4 above for the first time. Please edit it to 
"unique_subject = no". The error should be solved. You should be able to run command "b" over and 
over again with the certificate logged in "index.txt" for the same subject.

In order to upload the self signed certificate to the KVM switch, login to the KVM Switch and navigate 
to Device Management->Security->Private Certificate section and click "Browse" next to private key. 
Browse to the OpenSSL program directory and within the "bin" folder, choose "ca.key." Click "Browse" 
next to Certificate and find "ca.cer." Press Open and then Upload. You should receive a message saying 
Operation Succeeded.

Parameter Definition Max characters Example
/C Country: 2 US
/ST State or Province 32 Missouri
/L Locality 32 St. Louis
/O Organization: 64 Your Company, Ltd.
/OU Unit: 32 Techdoc Department
/CN Common Name: 32 mycompany.com

Note: This must be the exact domain name of the site that 
you want the certificate to be valid for. If the site's domain 
name is www.mycompany.com, and you only specify 
mycompany.com, the certificate will not be valid.

/emailAddress Email Address: 64 administrator@yourcompany.com
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Troubleshooting
General Operation
Problem Resolution
Erratic Operation Start the KVM switch before any tiered switches.

1. Power it on before powering on tiered switches.
2. If the tiered switch was started before the KVM switch, reset or restart 
the tiered switch.
Press and release the Reset switch (see “Reset Switch” on page 7).

I have been given an account but I am unable 
to log in.

1. Make sure your Username and Password are correctly specified.
2. Make sure that you have the necessary permission to access the switch.
3. Ask if the switch is under KVM Access management. If it is, the 
administrator will have to disable KVM Access management on the 
switch (page 70), or deselect it on the KVM Access server (see the KVM 
Access User Manual for details).

I can't access the switch, even though I have 
specified the IP address and port number 
correctly.

If the switch is behind a router, the router's Port Forwarding (also referred 
to as Virtual Server) feature must be configured. See “Port Forwarding” 
on page 106 for details.

When logging in from a browser, the 
following message appears: 404 Object Not 
Found.

If a login string has been set, make sure to include the forward slash and 
correct login string when you specify the KVM switch's IP address. (See 
“Login String” on page 76.)

Sudden loss of network connection. Close your connection to the KVM switch. Wait about 30 seconds, and 
log in again.

No remote server video display on the client 
computer.

Check that your KVM Adapter Cable's firmware version is the same as 
the version stored in the switch's Main firmware. See “Adapter Firmware 
Upgrade” on page 92 for details. Set the remote server resolution to 1280 
x 1024 or less.

No remote server video display on the client 
computer, but mouse movements appear on 
the local console and mouse clicks have no 
effect

Press and release the left Alt key, then press and release the right Alt key

The display on the client computer is distorted 
and performing an Autosync doesn't resolve 
the problem.

Switch ports to a port with a different resolution, then switch back. If that 
does not resolve the problem, change the resolution and refresh rate for 
the system running on the port. Afterward, you can run at the new 
resolution, or switch back to the original resolution.

The Lock Key LEDs on the Control Panel 
don't accurately reflect the actual locked status 
of my keyboard input.

Click the LEDs on the Control Panel until they match your keyboard. 
Afterward, when you change them from the keyboard they will change on 
the Control Panel.

When I log in, the browser generates a CA 
Root certificate is not trusted, or a Certificate 
Error response.

The certificate's name is not found on Microsoft's list of Trusted 
Authorities. The certificate can be trusted. See “Trusted Certificates” on 
page 112 for more information.

In multiuser operation I had exclusive (or 
occupy) rights on the port I was viewing. After 
I recalled the Port Access page and came back 
to the port I was occupying, it had been taken 
over by another user. Why did this happen?

If you try to return to the port by selecting again in the tree, the switch acts 
as if you are accessing the port for the first time. If another user was 
waiting on the port, he takes precedence and gets the port. The correct 
way to return to the port is to click the Close icon at the top right of the 
Port Access page.
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Mouse Problems

Problem Resolution
Mouse and/or Keyboard not responding Check that your KVM Adapter Cable's firmware version is the same as 

the version stored in the switch's Main firmware. See “Adapter Firmware 
Upgrade” on page 92 for details
Unplug the cable(s) from the console port(s), then plug it/ them back in.

Mouse movement extremely slow There is too much data being transferred for your connection to keep up 
with. Lower the video quality (see “Video Settings” on page 30) so that 
less video data is transmitted.

There are two mouse pointers after the remote 
server is accessed.

You can select another pointer type. See “Mouse Pointer Type” on 
page 34for details

When the mouse pointer is in Single Pointer 
mode, I can't access the Control Panel.

Recall the Control Panel and immediately change the pointer to Dual 
mode.

Why is there a Dual Pointer mode? When you are not in Mouse DynaSync Mode, you need the two pointers 
so that you know the remote server pointer is actually at the location you 
think it is at.
Otherwise, you might perform a mouse operation and because of net lag 
the remote server pointer may not be at the location that your client 
computer pointer is at.

Mouse pointer confusion If you find the display of two mouse pointers (local and remote) to be 
confusing or annoying, you can use the Toggle Mouse Display function 
to shrink the non-functioning pointer. See “Toggle mouse display” on 
page 28, and “Mouse Pointer Type” on page 34.

When I log in with my Windows system, the 
local and remote mouse pointers do not sync.

1. Check the status of the Mouse Sync Mode setting (see “Mouse 
DynaSync Mode” on page 34). If it is set to Automatic, change the 
setting to Manual and refer to the information for “Manual Mouse 
Synchronization” on page 35.
2. If you are in Manual mode, use the AutoSync feature (see “Video 
Settings” on page 30), to sync the local and remote monitors.
3. If that doesn't resolve the problem, use the Adjust Mouse feature 
(page 28) to bring the pointers back in step.
4. If the above fails to resolve the problem, refer to “Additional Mouse 
Synchronization Procedures” on page 108, for further details. 

When I log in with my Mac system, the local 
and remote mouse pointers do not sync.

There are two automatic Mouse DynaSync settings: the default, and 
Mac2. If mouse synchronization is not satisfactory with the default, try 
the Mac 2 setting. 

When I log in with my Sun system, the local 
and remote mouse pointers do not sync

Automatic Mouse DynaSync sync only supports USB mice on Windows 
and Mac (G4 or higher) systems. You must sync the pointers manually. 
See “Mouse DynaSync Mode” on page 34, and “Manual Mouse 
Synchronization” on page 35 for further details.
After doing the above, refer to Sun / Linux, page 108.

When I log in with my Linux system, the local 
and remote mouse pointers do not sync.

Automatic Mouse DynaSync sync only supports USB mice on Windows 
and Mac (G4 or higher) systems. You must sync the pointers manually. 
See “Mouse DynaSync Mode” on page 34, “Manual Mouse 
Synchronization” on page 35, and Mac and Linux Considerations, 
page 35, for further details.
After doing the above, refer to Sun / Linux, page 108, (under Additional 
Mouse Synchronization Procedures), for further details.
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Virtual Media

Web Browser

The WinClient ActiveX Viewer and the WinClient AP

Problem Resolution
Virtual Media doesn't work. The remote server's mainboard does not support USB. If there is a newer 

firmware and BIOS version for the remote server's mainboard - one that 
supports USB - get it from the manufacturer and upgrade the server's 
mainboard firmware and BIOS.

There is no Virtual Media icon on my Control 
Panel.

1. Virtual Media only supports devices connected with KVM-USBVM, 
KVM-USBVMCAC, KVM-PS2VMKA7175 or KA7176 KVM Adapter 
Cable Server Modules.
2. You must be have Administrator privileges on your client computer. 
(This is a Windows limitation.)

I can't boot my remote server from my Virtual 
Media drive.

Your remote server's BIOS doesn't support booting from a USB drive. 
Get the latest firmware and BIOS version for your mainboard from the 
manufacturer and upgrade your mainboard BIOS. 

If I connect a USB floppy drive to a remote 
server, it can boot the remote server. But, if I 
map it to the remote server as a Virtual Media 
drive, it cannot boot the remote server.

USB floppy drives have two types of format: UFI and CBI. Both can be 
used for OS level virtual media functions, but currently only UFI is 
supported for BIOS level (such as boot) functions.

I cannot mount a Folder as a Virtual Media 
device.

If the actual Folder is formatted with the FAT16 file system, it cannot be 
mounted if its size exceeds 2GB.

Problem Resolution
After upgrading the firmware, after logging in 
with my web browser, the switch appears to 
still be using the old firmware version.

The switch is using the new firmware version but the browser is 
displaying a page that is stored in its cache. Log out and clear your 
browser's cache. 
• IE: Tools > Internet Options > Temporary Internet Files > Delete Files
• Firefox: Tools > Clear Private Data

Firefox only opens the Java Applet Viewer. It 
doesn't open the WinClient ActiveX Viewer.

The WinClient ActiveX Viewer requires ActiveX. Since Firefox doesn't 
support ActiveX only the Java Applet Viewer is available.

Problem Resolution
My KVM switches don't show up in the 
Server List window when I start the WinClient 
AP program.

Only units whose Access Port settings for Program (see page 151) match 
the number specified for Port in the Server area of this dialog box appear 
in the Server List window. Make sure that your entry for Port matches the 
entry you have specified for Program on the Device Management 
Network page.

The WinClient ActiveX Viewer and the 
WinClient AP won't connect to the KVM 
switch.

DirectX 8.0 or higher must be installed on your client computer.

After upgrading the firmware, the WinClient 
ActiveX Viewer or WinClient AP do not run.

The old version of your .ocx file was not deleted. You must delete the old 
file. There are two methods to delete the file.
1. For the ActiveX Viewer: Open IE >Tools > Manage Add-ons. Delete 
or disable all occurrences of WinClient.
2. For the WinClient AP: Open Explorer and search for WinClient.ocx. 
Delete all occurrences.
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Part of the remote window is off my monitor 1. Perform an Auto Sync (see “WinClient Control Panel Functions” on 
page 26 for details).
2. If Keep Screen Size is not enabled (see “Screen Options” on page 35), 
use the AutoSync feature (see “Video Settings” on page 30), to sync the 
local and remote monitors.
3. If Keep Screen Size is enabled, you can scroll to the areas that are off 
screen.

The remote screen is rotated 90 degrees. Enable Keep Screen Size (see “Control Panel Configuration” on 
page 35).

I cannot run Net Meeting when the WinClient 
is running.

Enable Keep Screen Size (see “Control Panel Configuration” on 
page 35).

After logging in I can't open the WinClient 
ActiveX viewer.

1. You don't have the authority to install the WinClient Control add-on on 
your client computer. Have the administrator run the program the first 
time to get it installed. It will open for you after that.
2. Under Vista, you must also add the switch's URL 
Options>Security>Trusted Sites>Sites. 

Under Vista, after I open viewer and try to 
mount an open driver or removable disk, I get 
a “Driver not ready” message.

This is a result of Vista's UAC (User Account Control).
1. If you are your client computer's administrator, right click the browser 
icon and choose Run as. Then, choose to run the browser with the 
administrator account.
2. If you are not your client computer's administrator, you must ask the 
administrator to disable UAC.
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The Java Applet and Java Client AP

Sun Systems

Mac Systems

Problem Resolution
I can't connect to the KVM switch. 1. The latest Java version must be installed on your client computer.

2. Check if you need to specify the Program port along with the IP 
address. See “Java Client AP Login” on page 21 for details
3. Close Java reopen it, and try again.

I have installed the latest Java JRE, but I am 
having performance and stability problems.

There may be issues with the latest version because it is so new. Try 
using a Java version that is one or two versions earlier than the latest one.

After upgrading the firmware, after logging in 
with the Java Applet Viewer or the Java Client 
AP, the switch appears to still be using the old 
firmware version.

Log out. Delete your Java temporary internet files as follows:
• 1. Open Control Panel > Java.
• 2. In the Temporary Internet Files section, click Settings.
• 3. In the Disk Space section, click Delete Files.
• 4. In the dialog box that comes up, click OK.

The national language characters that I input 
do not appear.

Change the keyboard language of your client computer to English-UK. 
Use the KVM switch's On-Screen Keyboard and set the on-screen 
keyboard to the same language that the other system is using. 

Java performance deteriorates. Exit the program and start again.
Pressing the Windows Menu key has no effect. Java doesn't support the Windows Menu key.
When I try to add a folder to be mounted as a 
virtual media drive, I can't select the folder. 
My only choice is Desktop.

In the folder selection entry field, enter the root directory of the folder 
you want to add. After that, the folders contained under the root directory 
will display. You can now navigate to the folder you want.

Problem Resolution
Video display problems with interface 
systems(e.g. Sun Blade 1000servers).*

The display resolution should be set to 1024 x 768 @60Hz:HDB15 
Under Text Mode: Go to OK mode and issue the following command: 
setenv output-device screen:r1024x768x60reset-all
Under XWindow:
1. Open a console and issue the following command: 
m64config -res 1024x768x60
2. Log out
3. Log in

Video display problems with interface 
systems(e.g. Sun Ultra servers).*

The display resolution should be set to 1024 x 768 @ 13W3 60Hz:
Under Text Mode: Go to OK mode and issue the following 
command:setenv output-device screen:r1024x768x60reset-all
Under XWindow:
1. Open a console and issue the following command: 
fbconfig -res 1024x768x60
2. Log out
3. Log in

* These solutions work for most common Sun VGA cards. If using them fails to resolve the problem, consult the Sun 
VGA card's manual.

Problem Resolution
When I log in to the KVM switch with my 
Safari browser, it hangs when I use the 
Snapshot feature.

Force close Safari, then reopen it. Don't use the Snapshot feature until 
you upgrade to Mac OS 10.4.11 and Safari 3.0.4.
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Redhat Systems

The Log Server

Panel-Array Mode

Problem Resolution
With Redhat 9.0 (2.4.20-8) installed as server, 
the keyboard and mouse aren't working 
normally with the console modules.

Choose the AS3.0 setting for your mouse synchronization mode. See 
Mac and Linux Considerations, page 80 for details

With Redhat 9.0 (2.4.20-8) installed a desktop 
system, the keyboard and mouse aren't 
working normally with the console modules.

First, plug your keyboard and mouse into a USB 2.0 hub, then plug the 
hub into the Redhat 9.0 server.

Problem Resolution
The Log Server program does not run. • The Log Server requires the Microsoft Jet OLEDB 4.0 driver in order to 

access the database. This driver is automatically installed with Windows 
ME, 2000 and XP.

• For Windows 98 or NT, go to the Microsoft download site: http://
www.microsoft.com and search for MDAC to retrieve the driver file: 
MDAC 2.7 RTM Refresh (2.70.9001.0)

• Since this driver is used in Windows Office Suite, an alternate method 
of obtaining it is to install Windows Office Suite. Once the driver file or 
Suite has been installed, the Log Server will run.

Problem Resolution
Low resolution video - the screens don't 
display clearly.

This can occur due to the screens being scaled to fit in the panels. 
Decrease the number of panels that are displayed.

When multiple remote users are logged in, 
some of them only receive a partial image.

The first user to invoke Panel Array Mode should set it to display at least 
four panels.

When I try to move forward or backward one 
port, the display sometimes moves forward 
two ports or remains on the original port.

• This can occur due to a net lag problem. The array automatically moves 
through the ports at a pre-selected time. By the time it gets your input, it 
has already moved forward a port on its own - but that hasn't shown up 
on your display as yet. When it moves ahead or back due to your input, 
it appears to have moved two ports (from its own movement plus your 
“forward one port” command), or remains on the original port (from its 
own forward movement plus your “back one port” command).
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Specifications
KVM2132P / KVM2116P / KVM1116A

Function KVM2132P KVM2116P KVM1116A
Computer 
Connections

Direct 32 16 16
Max 8192 4096 256
Local 1 1 1
Remote 2 2 1

Connectors Console Port Keyboard 1 x 6-pin Mini-DIN 
Female (Purple)

1 x USB Type A Female 
(Black)

1 x 6-pin Mini-DIN 
Female (Purple)

1 x USB Type A Female 
(Black)

1 x 6-pin Mini-DIN 
Female (Purple)
1 x USB Type A 
Female (Black)

Video 1 x HDB 15 Female 
(Blue)

1 x HDB 15 Female 
(Blue)

1 x HDB 15 Female 
(Blue)

Mouse 1 x 6-pin Mini-DIN 
Female (Green)

1 x USB Type A Female 
(Black)

1 x 6-pin Mini-DIN 
Female (Green)

1 x USB Type A Female 
(Black)

1 x 6-pin Mini-DIN 
Female (Green)
1 x USB Type A 
Female (Black)

KVM Port 32 x RJ-45 Female 
(Black)

16 x RJ-45 Female 
(Black)

16 x RJ-45 Female 
(Black)

Power 2 x IEC C14 2 x IEC C14 1 x IEC C14
PDU 2 x RJ-45 Female (Black) 2 x RJ-45 Female 

(Black)
1 x RJ-45 Female 

(Black)
LAN 2 x RJ-45 Female (Black) 2 x RJ-45 Female 

(Black)
2 x RJ-45 Female 

(Black)
Virtual Media USB 3 x USB Type A Female 

(Black)
3 x USB Type A Female 

(Black)
3 x USB Type A 
Female (Black)

Switches Reset 1 x recessed Pushbutton 1 x recessed Pushbutton 1 x recessed Pushbutton
LEDs Port 32 (Green/Red/Orange) 16 (Green/Red/Orange) 16 (Green/Red/Orange)

Power 1 (Blue) 1 (Blue) 1 (Blue)
LAN 2 (Green/Red/Orange) 2 (Green/Red/Orange) 1 (Green/Red/Orange)

Emulation Keyboard/Mouse PS/2 / USB / Serial PS/2 / USB / Serial PS/2 / USB / Serial
Video 1600x1200 @ 60Hz 1600x1200 @ 60Hz 1600x1200 @ 60Hz
Scan Interval 1-255 secs 1-255 secs 1-255 secs
I/P Rating 100-240VAC; 50-60Hz; 

1.0A
100-240VAC; 50-60Hz; 

1.0A
100-240VAC; 50-60Hz; 

1.0A
Power Consumption 25.9W 25.9W 15.6W
Environment Operating Temp. 32°F - 122°F (0 - 50°C) 32°F - 122°F (0 - 50°C) 32°F - 122°F (0 - 50°C)

Storage Temp. -4°F - 140°F (-20°C to 
60°C)

-4°F - 140°F (-20°C to 
60°C)

-4°F - 140°F (-20°C to 
60°C)

Humidity 0 - 80% RH, Non-
condensing

0 - 80% RH, Non-
condensing

0 - 80% RH, Non-
condensing

Physical 
Properties

Housing Metal Metal Metal
Weight/Shipping Weight 3.6 kg/5.1 kg 3.6 kg/5.1 kg 2.6 kg/4 kg
Dimensions L x W x H 42.4 x 23.8 x 4.25 cm 

(19” 1U)
42.4 x 23.8 x 4.25 cm 

(19” 1U)
42.4 x 18.8 x 4.25 cm 

(19” 1U)
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Radio Frequency Interference
Changes or modifications to this unit not expressly approved by the party responsible 
for compliance could void the user’s authority to operate this equipment.

USA—FCC

This equipment has been tested and found to comply with the limits for a Class A digital device, 
pursuant to part 15 of the FCC Rules. These limits are designed to provide reasonable protection 
against harmful interference when the equipment is operated in a commercial environment. This 
equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in 
accordance with this user manual, may cause harmful interference to radio communications. Operation 
of this equipment in a residential area is likely to cause harmful interference. The user will bear sole 
responsibility for correcting such interference.

Canada—ICES

This Class A digital apparatus complies with Canadian ICES-003. 

Cet appareil numérique de la classe A est conforme à la norme NMB-003 du Canada.

Japan—VCCI

This is a Class A product based on the standard of the Voluntary Control Council for Interference by 
Information Technology Equipment (VCCI).  If this equipment is used in a domestic environment, 
radio disturbance may occur, in which case, the user may be required to take corrective actions.

この装置は、情報処理装置等電波障害自主規制協議会（VCCI）の基準
に基づくクラス A 情報技術装置です。この装置を家庭環境で使用すると、電波
妨害を引き起こすことがあります。この場合には、使用者が適切な対策を講ず
るように要求されることがあります。

Taiwan—BSMI
警告使用者 :
這是甲類的資訊產品 , 在居住的
環境中使用時 ,可能會造成射頻
干擾 , 在這種情況下 ,使用者會
被要求採取某些適當的對策。
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APC Worldwide Customer Support
Customer support for this or any other APC product is available at no charge in any of the following ways:

• Visit the APC Web site to access documents in the APC Knowledge Base and to submit customer 
support requests.
– www.apc.com (Corporate Headquarters)

Connect to localized APC Web sites for specific countries, each of which provides customer support 
information.

– www.apc.com/support/
Global support searching APC Knowledge Base and using e-support.

• Contact the APC Customer Support Center by telephone or e-mail.
– Local, country-specific centers: go to www.apc.com/support/contact for contact information.

For information on how to obtain local customer support, contact the APC representative or other distributors 
from whom you purchased your APC product. 
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